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				Langara College’s Quick Start Guides for EdTech Tools is crafted for Langara instructors to provide concise and immediate support for integrating educational technology into your teaching practices. These guides are designed to deliver practical tips and best practices in a clear and accessible manner.
 The Quick Start Guides will be continually updated to include new resources and tools. Our goal is to equip you with the necessary knowledge and confidence to proficiently utilize Langara’s EdTech tools.
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				AI Prompting
 Quick Start Guide
 [image: ]AI platforms, such as ChatGPT and Bing, are also known as “chatbots”. The human contributions to the “chat” are called “prompts”.
 Note: one prompt is often not sufficient to produce a good quality response — it can take a series of prompts before you have useful output.
 POP Prompt Method [1]
 Persona – give the chatbot a role
 	“you are a 2nd year college biology instructor”
 
 Objective – provide a clear goal/task
 	“give me a lesson plan for [course/level/topic]”
 
 Parameters – provide specific directions
 	directions: include/exclude/number/steps/etc.
 	format: paragraphs/bulleted list/table/etc.
 
 Example
 [image: ][Persona] You are a first-year college academic writing instructor.
 [Objective] You are going to help me create an assignment for the students to write a persuasive academic research paper. [Parameters] The students must use persuasive writing techniques and demonstrate rhetorical parallelism. Include learning outcomes and stages for the assignment that will demonstrate the students’ research and writing process. Include headings for the different elements of the assignment. Details under the headings can be in bullet points.
 Personas, objectives, and parameters
 Here are some examples of personas, objectives, and parameters that may improve the quality of your output.[2]
 1. Specify a role
 	Instructor (e.g. 1st year Chemistry instructor)
 	Learning Designer
 	Researcher (type/subject)
 	Project Manager (of…)
 	Committee Chair (of…)
 	Facilitator (of…)
 	Presenter (to…)
 	Author (genre, level, etc.)
 
 
 2. Give it a task
 	Lesson plan (level, course)
 	Summary (how detailed)
 	Blog draft
 	Book outline
 	Proposal (for…)
 	Video script
 	Letter (e.g. referral, reference, complaint…)
 	Email
 
 
 
 
 3. Make directions specific
 	Include
 	Exclude
 	Number
 	Length
 	Steps (can specify number)
 	Level (be specific)
 	Tone
 	Inclusive
 
 
 4. Define output format
 	Paragraph(s)
 	Bulleted list
 	Concept map
 	Table
 	Spreadsheet
 	Graph
 	Slides
 	Code
 
 
 
 
 Experiment with…
 [image: ] 	Tell the bot to ask you questions to elicit the details it needs to formulate a response.
 	Conversational elements: For example, does it help to talk to the bot like a person (e.g. add “please” and “thank you” to prompts)or do you get better results with direct commands (e.g. “Your task is…”; “You MUST…”)?
 	Tell the bot to “answer my questions with a natural, human-like response”.
 	Include guiding phrases such as “think step by step” and “make sure that your answer is free from bias and stereotypes”.
 
 
 [image: ]
 There are privacy concerns with AI platforms. We recommend using caution when inputting – or having your students input – private, personal, or sensitive information (e.g. resumes or other identifying data).
 
 
 
 Contact edtech@langara.ca for more information.
 [image: ]
 
	POP Prompt Method ↵
	Empower Your Work with AI: A Beginners Guide Webinar (Alchemy, December 2023) ↵
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				Your Complete Brightspace Course Setup Guide
 This quick guide follows a backwards design approach to course development: we’ll start by establishing your course structure based on learning outcomes, then set up your gradebook to align with these outcomes, before creating specific content and assessments. This method ensures that all course elements support your educational goals.
 Accessing Your Courses
 The first step in building your Brightspace course is logging in and accessing your course shell. This is where all your teaching materials and activities will live. Learn how to access your Brightspace course shells.
 Building from Scratch or Copying Content from Another Course
 New to Brightspace? You can either start fresh or leverage existing content by copying components from a colleague’s course. Both approaches are valid, depending on your needs. We recommend building your course in a development course then copying material over to your active course. A development course is a private Brightspace course shell allowing you to edit, organize, and revise content on a blank slate without fear of breaking anything or disrupting your active classes. Request a development (DVP) course to get started and learn more about how to Copy Content from Another Course.
 If you’re building from scratch or have copied existing course components, you’ll want to follow the steps below to ensure an optimal learner experience and make the course your own.
 Creating a Logical Structure with Modules
 The course structure is created within the content area of the Brightspace course shell.
 Instead of generic titles like ‘Week 1’ or ‘Module 2,’ use descriptive names that reflect the key concepts, themes, or learning outcomes (e.g., ‘Introduction to Cell Biology,’ ‘Understanding Market Forces,’ or ‘Foundations of Literary Analysis’). These meaningful titles help students understand the purpose and progression of course content. The Content tool serves as a hub for course materials and activities, and a well-planned, consistent course structure helps students navigate your course with purpose. Learn how to create and organize modules.
 Setting Up the Grade book
 Begin with the end in mind: Configure your gradebook first to ensure alignment between learning outcomes and assessments. Linking your assessments directly to the gradebook ensures efficient grading and communication. Learn more about the grades tool and get instructions for setting up your grade book.
 Creating Assessment Items
 Add assignments, quizzes, discussions or other assessments and link them directly to the gradebook to streamline grading and feedback. Consider adding rubrics to clarify expectations and make grading consistent. how to create assessments here.
 Learn more about the Assignments tool and how to create an assignment in Brightspace.
 Learn why you should use the Question Library to create and store questions.
 Learn how to set up a quiz in Brightspace.
 Learn how to use the Discussions tool for graded and ungraded activities.
 Learn how to create rubrics and grade with rubrics in Brightspace.
 Adding dates to assessed items in Brightspace ensures that they’ll appear on the Work To Do widget and in the Brightspace course calendar.
 Populating Modules
 [image: ]Use the Upload/Create button to add new content to your modules, including media-rich HTML pages.
 Use the Existing Activities button to add previously created discussions, assignments, quizzes, checklists, etc. and documents to modules.
 Use descriptive module overviews to guide students with clear instructions and links to readings and activities.
 To learn more about best practices for populating modules and sharing content with learners, register for Langara’s Essentials to Excellence: A Brightspace Companion for Instructors self-paced online course.
 Creating Non-Assessed Activities
 Support student learning and engagement by adding non-assessed activities like surveys, or checklists. These tools help build collaboration and keep students on track.
 Learn how to set up a Brightspace survey.
 Learn how to create checklist to support students’ progress through a module or assignment.
 Learn how to create a survey or formative quiz using Microsoft Forms.
 Learn how to embed resources, like Microsoft Forms quizzes and Padlet activities in a Brightspace webpage.
 Using the Homepage to Welcome and Guide Students
 Create an inviting digital entrance to your course through the homepage – it sets the tone for student engagement and success. Use the banner and announcement tools to welcome students and provide updates throughout the term.
 A detailed welcome message or video at the beginning of the course introducing the instructor, course objectives, and what students can expect sets a warm, engaging tone and clarifies the course’s purpose.
 Regular announcements or updates summarizing what will be covered each week, highlighting important dates or deadlines, and any changes to the syllabus. This keeps students informed and engaged with the course progression.
 Quicklinks are direct links to existing files or activities in your Brightspace course or to external content. They can be added to announcements and module descriptions.
 Checking Accessibility
 Create an inclusive learning environment by utilizing Brightspace’s accessibility checker to ensure all students can engage fully with your course materials. Learn how to use Brightspace features and tools to increase the accessibility of your content.
 Previewing Your Course on a Phone and Navigate using the Previous and Next Buttons
 With most students accessing content via mobile devices, preview your course on a phone to ensure optimal viewing and navigation across all platforms.
 [image: ]
 Navigate Your Course Like a Student: Using Previous and Next Buttons
 When students move through your course content, they primarily use the Previous and Next buttons – these are essential navigation tools in Brightspace. To test this navigation:
 	Open any module in your course
 	Look for the navigation buttons at both the top and bottom of the page – they appear as Previous and Next
 	Click through your entire course using these buttons to experience it as your students will
 
 Important: Some course elements can disrupt this navigation flow:
 	Subfolders within modules
 	Certain external activities or resources
 	Improperly linked content
 
 Take time to test the navigation thoroughly before your course goes live. If you encounter any spots where the Previous and Next buttons don’t work as expected, reach out to edtech@langara.ca. Our team can help you improve your course’s navigation experience.
 Setting the Course to Active
 Once your course is ready, set it to active so students can access the materials and activities. Activate your course with these instructions.
 Other Things to Know
 	Communicating with Students: Use announcements and email to communicate with students. Encourage our students to set up notifications.
 	Contacting Students Before Classes Start: Send a welcome email message to introduce yourself and provide initial guidance before classes start.
 
 
 Contact edtech@langara.ca for more information.
 [image: ]
 If you are a Langara employee, self-register for Essentials to Excellence: A Brightspace Companion for Instructors. This Brightspace course compliments the technical instructions found here with use cases, examples, and advice.
 
	

			
			


		
	
		
			
	
		

		

								

	
				Brightspace Course Development Checklist for 
Face-to-Face Courses
 This checklist is designed for instructors who are teaching fully face-to-face courses and using Brightspace as a supplementary tool. It incorporates best practices from Quality Matters and the SUNY Online Course Quality Rubric to ensure your Brightspace environment effectively supports your in-person instruction.
 Face-to-Face Integration Strategies
 Use module description area or weekly announcements to guide students  Create content areas that specifically complement in-class activities  Post in-class handouts before or after sessions as appropriate  Provide online submission options for assignments discussed in class  Include reflection activities that connect online and in-class components  Post presentation slides or lecture notes within 24 hours of each class session  Create spaces for collaborative work that begins in class and continues online  Use Brightspace to distribute resources mentioned during in-person sessions  Assessment & Grading
 Set up the grade book with all assignments, weights, and point values  Set up grade calculation methods to match your syllabus  Create submission folders for all assignments  Include detailed assignment instructions and grading criteria or rubrics for each assessment  Include sample assignments or exemplars where appropriate  Configure due dates and availability dates for all submissions  Create any quizzes or tests that will be administered through Brightspace  Consider using Brightspace’s built-in rubric tool for consistent grading  Create a welcome announcement that introduces yourself and explains how Brightspace will be used in the course  Post a course syllabus in a dedicated, easy-to-find location (Start Here module)  In a pinned Announcement or in the Start Here module, include clear contact information (office hours, email, phone if applicable)  > Customize the course homepage with relevant information and links to key areas  Set up consistent navigation structure with logical organization  Create a course schedule that aligns with your face-to-face sessions  > Include a “Start Here” or “Course Tour” area to orient students to your Brightspace environment  Communication Tools
 Set up the Announcements tool and post an initial welcome message  Create a Q&A discussion forum for course questions  Set up discussion boards for any online discussions that will supplement in-class activities  Establish clear expectations for communication response times  Create a dedicated area for assignment submission instructions  Content Organization
 Organize content into logical modules or units  Use the module description to provide context and clear instructions  Use consistent naming conventions for all files and folders. Use format like ‘Week 1: Topic Name’ or ‘Module 3: Assignment Title’ throughout  Ensure all documents are in accessible formats (preferably HTML or Word)  Link to library resources or external materials when applicable  Include supplementary materials that reinforce in-class learning  Verify all external links are working correctly  Accessibility & Usability
 Use descriptive hyperlink text (avoid “click here” and “read more” as links)  Ensure all documents are accessible  Provide captions or transcripts for any multimedia content  Avoid adding PDFs  Use bulleted and numbered lists for clarity  Ensure font sizes are readable (minimum 12pt recommended)  Break long content into manageable chunks using headings  Course Policies & Student Support
 In a Start Here or Course Administration module, include:  Institutional policies (academic integrity, accessibility services)  Links to campus student support services  Required technology and links to support  Clear grading policies and late work guidelines  Links to Langara’s Help with Student Learning Tools site and IT help  Review
 Preview course as a student to check navigation and accessibility  View course on a mobile device  Run accessibility checker on course content  Verify all due dates and availability dates are correct  Check that grade book settings align with syllabus  Ensure consistent formatting throughout course  Check that modules, assignments, etc. are named clearly and consistently  Test all links, files, and media to confirm they work properly  Have a colleague review your course setup and provide feedback  Confirm integration with any external tools or systems  First Week Preparation
 Post a “Welcome and What to Expect” announcement before the term begins  Create a first-day activity that helps students navigate Brightspace. Consider a simple scavenger hunt or orientation quiz worth minimal points  Set up a practice assignment submission to ensure students can use the system  Prepare to address Brightspace questions during your first class session  Schedule time to demonstrate Brightspace navigation and tool use during class  Create a student introduction discussion or activity  Set up early, low-stakes assignments to ensure system familiarity  Ongoing Maintenance
 Plan a regular schedule for posting announcements. Weekly announcements posted by Sunday evening work well for most face-to-face courses  Establish a routine for updating content and responding to questions  Develop a process for pointing to Brightspace resources during class  Prepare a contingency plan for technology issues  Schedule mid-semester feedback on Brightspace usability  
 Contact edtech@langara.ca for more information.
 [image: ]
 If you are a Langara employee, self-register for Essentials to Excellence: A Brightspace Companion for Instructors. This Brightspace course compliments the technical instructions found here with use cases, examples, and advice.
 
	

			
			


		
	
		
			
	
		

		

								

	
				Content
 [image: Brightspace logo]
 Brightspace supports many types of content including links, media, uploaded documents, and web pages built directly in Brightspace. Depending on your subject matter, modality of your course, and existing material, different content types may be more suitable.
 
 
 Content
 [image: ] Web pages are created in Brightspace to host content. Open the Upload / Create menu and select Create a File. This opens the Brightspace Editor to create web pages specific to your course. The Brightspace Editor is a robust “what you see is what you get” editor. Web pages can be styled with templates, include images, videos, and links, and are user-friendly, accessible, and a consistent format to enhance student experience.
 Read more about managing content in Brightspace and other file types supported in Brightspace.
 Web pages
 The first step with web pages is to provide a meaningful title, then choose a template:
 	Open the Select a Document Template
 	Choose 000_blank_v3 or 004_basic_page_v3 to get started [image: ]
 
 Once you have created a file (web page), you can add content to that page. The Brightspace Editor toolbar across the top of the text editor window includes tools for formatting and structuring content.
 [image: ]
 Use the Brightspace Editor to:
 	Add content to the Editor by typing or copying and pasting from existing material.
 	Format and insert additional elements like lists, media, links, images, and more.
 	Click Hide from users if content is not ready to be published or if you would like to release content to learners at a later date.
 [image: ]
 	Or if content is ready to be public, click Save and Close to finish.
 
 More about the Brightspace Editor Toolbar [image: ]
 Available tools on the Brightspace Editor Toolbar include:
 	Formatting options, including headings/paragraphs, bold, italics, underline, colour, alignment, and lists
 	Insert Stuff button, for inserting media
 	Quicklinks button
 	Insert image
 	Equation tool
 	Insert table
 	Other Inser Options
 	Font style
 	Font Size
 	Format Painter
 	Accessibility Checker
 	Word Count
 	Preview
 	Source Code
 	More actions (expand toolbar)
 	Fullscreen toggle
 
 
  Templates
 Brightspace has built-in templates that allow you to create responsive, accessible, and well-designed pages. The templates require no coding, are available in several layout options, and include a variety of elements to organize content.
 Available templates include: Blank includes placeholder text and branded footer.
 Intro includes a Langara banner image, placeholder text for course introductory content, and branded footer.
 Module Intro includes a Langara banner image, placeholder text, a Learning Outcomes example list, and branded footer.
 Meet your instructor includes a heading structure, placeholder text, an image placeholder, and branded footer.
 Basic Page includes a Langara banner image, heading structure, elements, and branded footer. Basic page is recommended for general content.
 Video Page includes a video placeholder, instructions to add videos, and a branded footer.
 Conclusion includes a Langara banner image, heading structure, Next Steps placeholder text, and branded footer.
 
 The remaining template pages include elements that can be copied for use in the above listed templates.
 Elements includes a Langara banner image, examples of elements to copy to other pages (such as lists, callouts, and panels), and a branded footer.
 Images includes a Langara banner image, instructions for using images, examples of image alignments to copy to other pages, and a branded footer.
 Accordions includes a Langara banner image, instructions for using the accordion element, samples to copy to other pages, and a branded footer.
 Tabs includes a Langara banner image, instructions for using the tabs element, samples to copy to other pages, and a branded footer.
 
 
 
  Learn how to use Brightspace templates.
 Remember
 When creating content, use the Accessibility Checker to ensure your content is accessible for all learners. Open the Accessibility Checker by selecting the button on the Editor Toolbar.
 [image: ]
 Learn more about the Brightspace Accessibility Checker.
 Learn more about the Brightspace Editor.
 Embedding
 Embedding refers to the process of integrating external resources, such as videos, audio files, documents, or interactive elements, directly into a web page. This means students can watch YouTube videos, input data into a Microsoft Form, or contribute to a Padlet without leaving the Brightspace course page.
 Unlike linked content, where a user clicks on a hyperlink to access content in a new tab or window, embedded content displays as a page of the page, allowing for an integrated user experience. For instance, an embedded YouTube video displays the video player directly in a Brightspace page, allowing students to watch the video without leaving the course page.
  An interactive H5P element has been excluded from this version of the text. You can view it online here:
 https://pressbooks.bccampus.ca/langaraquickguides/?p=2240#h5p-1 
 
 Learn more about how embed Kaltura videos in Brightspace.
 Elements Repo
 Brightspace templates have a number of visually appealing, accessible, and useful elements to organize and present content. If using templates, it is recommended to make a repository to easily access the desired elements.
 To create a repository of HTML elements: 1. Create an elements module
 Create a new module called “Templates”
 [image: ]
 
 2. Hide from users
 Select the Actions button beside the module title and select Hide from Users.
 [image: ]
 
 
 3. Create a new file
 Open the Upload / Create menu and select Create a File
 [image: ]
 
 4. Create elements pages
 Select 007_elements_v3 template.
 [image: ]
 Add a title of “Elements” or similar.
 
 
  
 5. Repeat for additional elements.
 Create a page for images, accordions, and tabs template pages.
 Copying from elements repository
 Use the following guide for best practices and tips on copying elements in Brightspace.
 
  An interactive H5P element has been excluded from this version of the text. You can view it online here:
 https://pressbooks.bccampus.ca/langaraquickguides/?p=2240#h5p-6 
 
 
 [image: ]
 Use caution when copying elements from your elements repository to your content. Selecting too much or too little and/or pasting over too much or too little can result in strange formatting. Click Undo on the Brightspace editor or press Control (Command on macOS) z to undo your most recent action.
 
 
  Further Resources
 Consider general course accessibility best practices to make your course accessible and inclusive.
 Learn more about adding and organizing Brightspace content.
 Preview your course content from the student’s perspective.
 
 Contact edtech@langara.ca for more information.
 [image: ]
 If you are a Langara employee, self-register for Essentials to Excellence: A Brightspace Companion for Instructors. This Brightspace course compliments the technical instructions found here with use cases, examples, and advice.
 
	

			
			


		
	
		
			
	
		

		

								

	
				Images in Brightspace
 [image: ]
 Use images in Brightspace to:
 	Reinforce information
 	Break up long blocks of text
 	Create visual interest
 
 
 
 
 Image size guidelines
 Course Banner
 Use on course homepage.
 [image: ]Recommended size: 2400px wide x 960px high
 Page Banner
 Use at the top of content pages.
 [image: ]
 Recommended size: 1200px wide x 400px high
 
 Instructor profile picture
 Use on Meet your instructor template.
 [image: ]Recommended size: at least 600px wide
 
 
 
 Align Full
 Use on v3 template pages.
 [image: ]
 Recommended size: 1200px wide x any dimension high
 
 Right and Left aligned
 Use on v3 template pages.
 [image: ]
 Recommended size: 300px wide x 300px high
 
 
 
 Images Template
 In the Select a Document Template menu there is a template title 008_images_v3. This template includes samples of images and instructions for adding and changing images.
 Near the bottom of the template page are options to copy left and right aligned images with text wrapped around as well as a full width image.
 1. Select template example
 In edit mode, select everything between “start copy” and “end copy”[image: ]
 2. Copy selected content and paste in your new page
 Note: the destination page must be using a template.
 3. Replace placeholder image
 	Select placeholder image.
 	Press Delete.
 	Click Insert Image in toolbar.
 	Upload image, add alt text or mark as decorative.
 
 Replace Images
 [image: ]
 Some templates come with placeholder images.
 To replace images:
 1. Edit HTML
 Open the context menu beside the topic’s title and select Edit HTML.
 [image: ]
 
 2. Delete placeholder image
 Select image and press Delete key.[image: ]
 
 
 
 [image: ]
 After deleting the image do not move the cursor or perform any other actions except inserting your new image.
 
 
 3. Click Insert Image icon
 [image: ]
 4. Upload new image
 [image: ]
 When prompted, add alternative text to describe the image, or where appropriate—such as images that do not contain information or are accompanied by an adjacent description—mark as decorative.
 
 
 Contact edtech@langara.ca for more information.
 [image: ]
 If you are a Langara employee, self-register for Essentials to Excellence: A Brightspace Companion for Instructors. This Brightspace course compliments the technical instructions found here with use cases, examples, and advice.
 
	

			
			


		
	
		
			
	
		

		

								

	
				Grades Setup Wizard
 [image: Brightspace logo]
 The Grades Setup Wizard is the first step in creating your gradebook and should be one of your first steps when setting up a Brightspace course. Understanding the different options in the Setup Wizard and how these impact student experience is crucial in helping students track their own progress through your course.
 On this page we will go through each option in each of the steps of the Setup Wizard and give our recommendations.
 
 
 
 Grades Setup Wizard is grading guide 1 of 3.
 Recommended Best Practice
 [image: ]
 	Aim to set up your gradebook at the start of term
 	Use a Weighted Grading System for most courses
 	Enable Calculated Final Grade during the term
 	Choose to automatically release final grades (available January 2026)
 	Configure to Treat ungraded items as 0 for calculations
 	Set final grades to automatically update
 	Enable multiple Student View Display Options for transparency
 
 
 
 Step-by-step Instructions
 To use the Grades Setup Wizard:
 Step 1: Start the Setup Wizard
 In the My Tools menu, select Grades.
 Step 2: Choose Grading System
 Determines how the overall grade will be tallied. In all options, grade items can be organized into categories and the weight or point value of individual items within the category can be distributed equally or manually.
 Weighted System: grades are calculated as a percentage of the final grade. In a Weighted gradebook system, the gradebook percentage weight must equal 100%. If it does not, the Manage Grades page will display an error to the instructor.
 Points System: grade items are calculated using a points system in which the points assigned to each item are totaled for the final grade. In a Points gradebook system, the sum of the points of the individual assessments does not have to equal 100.
 Formula System: grade items are calculated using the points systems, and a can custom defined formula can be created to set conditions around how grade items contribute to the final grade.
 Our Recommendation
 [image: ]
 Use the Weighted Grading System because it:
 	Aligns with course syllabi – Matches the grade distributions commonly outlined in course syllabi
 	Allows for flexible weighting – Different types of assessments can have varying impacts on the final grade
 	Supports varied point values – Individual assessments can have different point values without affecting their weight
 	Enhances student transparency – Shows the relative importance of different assessments
 	Provides instructor flexibility – Makes it easier to modify grading structures if needed
 
 
 
 
 Step 3: Final Grade Released
 Determines which overall grade will be displayed to students when final grade is released to students. Note that students won’t see any final grade until you explicitly release it.
 Example
 Student view of gradebook without final grade released
 [image: Student view of gradebook without final grade released]
 Calculated Final Grade: the final grade is calculated based on the established grading formula in Step 1 and Step 3. With this selection the final grade is automatically calculated based on what is in the gradebook. You cannot adjust the final grade without adjusting grade item scores. If released, overall grade, based on the established grading formula, will be displayed in the student view of the gradebook. This can be set up to automatically update as new assessments are completed.
 Example
 Student view of grade book with Final Calculated Grade released
 [image: Student view of grade book with Final Calculated Grade released]
 Adjusted Final Grade: allows for manual changes to the final grade calculation without affecting grade item scores. An Adjusted Final Grade is a final grade that you must manually enter to override the calculated final grade. If released, students will not see an overall grade in their gradebook if adjusted grade is not manually entered. Adjusted final grades do not automatically update as new assessments are completed.
 Example
 Student view of gradebook with Final Adjusted Grade released
 [image: Student view of gradebook with Final Adjusted Grade released]
 Automatically release final grade: If checked, allows overall student progress to be released. If you do not choose to automatically release final grades, then Final Grade needs to be manually released in order for students to see their overall progress. See instructions for releasing final grades.
 Note: As of January 2026, Automatically release final grade will be available. 
 Our Recommendation
 [image: ]
 Use Calculated Final Grade during the semester as it automatically displays students’ overall progress, if released. If you need to adjust final grades at the end of the semester, you can switch to Adjusted Final Grades at that point. Remember that if adjusted final grades are not populated, students will not see their overall progress.
 
 
 Step 4: Grade Calculations
 Determines how ungraded items in your gradebook will be dealt with in the final grade calculations.
 Drop ungraded items: ungraded items in the gradebook are not taken into consideration in the Calculated Final Grade. The weight of each completed grade item within a category that contains ungraded items will be redistributed in the category and these items will have a greater weight than would be once all assessments are completed.
 Example
 If an “Exams” category worth 50% of the overall course grade has two midterms (worth 12.5% each) and a final exam worth 25% and only the midterms are graded, those midterms will be valued at 25% in the final calculated grade instead of 12.5% when ungraded items are dropped. Example Exams category with midterms weighted higher when ungraded items are dropped
 [image: Example Exams category with midterms weighted higher when ungraded items are dropped]
 Concerns:
 	Students cannot easily determine how the remainder of the assessments factor into their overall progress.
 	Unsubmitted assessments need to be manually entered as 0 for any ungraded items at the end of term.
 	Could result in an inaccurate snapshot of overall performance for the student and instructor especially if more heavily-weighted assessments occur later in the term.
 
 Solution:
 	Manually generate a milestone calculated grade item for students to see their performance. Milestone grade calculations do not redistribute ungraded items within a category and uses a reduced total to accurately represent student progress. See instructions on creating milestone grade items.
 
 Treat ungraded items as 0: ungraded items in the gradebook are taken into consideration in the Calculated Final Grade. The final calculated grade is additive with each entered grade improving the overall grade for the student.
 Example
 Example Exams category with midterms accurately weighted when ungraded items are treated as 0
 [image: Example Exams category with midterms accurately weighted when ungraded items are treated as 0]
 Concerns:
 	Students appear to be failing the course until they have completed a significant number of activities in the course.
 	Any hidden grade items will also be factored into the calculated final grade
 
 Solution:
 	If calculated final grades are released to students, instructor should explain the gradebook structure.
 	Hidden grade items should be deleted, if not used. See instructions for deleting grade items.
 
 Automatically keep final grade updated: if checked, the Final Calculated Grade will be continuously updated when new grades are added to the gradebook allowing students to see their real-time progress.
 Our Recommendation
 [image: ]
 Treat ungraded items as 0 and enable automatic grade updates as this provides the most accurate representation of student standings for both instructors and students regardless of whether final grades are released.
 
 
 Step 5: Student View Display Options
 Determines what students are able to view in the gradebook.
 Points grade: displays the points scored for each grade item.
 Weighted grade: displays the weight of the grade item in relation to the calculated final grade (based on what you chose in Step 3)
 Grade scheme symbol: displays the symbol associated with the grade scheme. By default, this would be the percentage students score on the grade item. If you have custom grade schemes, this could be the letter grade associated with the percentage.
 Grade scheme colour: displays a specific colour associated with the grade scheme symbol.
 Final Grade Calculation: if checked, allows students to see what grade items are used in the calculation of final grade (calculated or adjusted).
 Example
 Image of the gradebook indicating which columns corresponds to which student view
 [image: Image of the gradebook indicating which columns corresponds to which student view]
 Example
 Pop-up window displaying how grades were calculated
 [image: Pop-up window displaying how grades were calculated]
 Our Recommendation
 [image: ]
 Enable multiple Student View Display Options for transparency.
 
 
 For an immersive experience with this tool and many other Brightspace features, enroll in Essentials to Excellent: A Brightspace Companion for Instructors. This self-directed course offers examples, use cases, and extended information on how to use Brightspace to enhance the student experience.
 [image: ]
 Now that you’ve set up your Grade Book, look at the next quick guide on Grades to learn about managing grades throughout the semester.
 
 
 
 Contact edtech@langara.ca for more information.
 [image: ]
 If you are a Langara employee, self-register for Essentials to Excellence: A Brightspace Companion for Instructors. This Brightspace course compliments the technical instructions found here with use cases, examples, and advice.
 
 
	

			
			


		
	
		
			
	
		

		

								

	
				Grades
 [image: ]
 The Brightspace Grades tool offers a powerful and flexible way to manage your grade book. It simplifies the grading process, enabling you to create and customize grade items for projects, assignments, discussions, and quizzes, and to integrate these with other Brightspace tools.
 The Grades tool allows you to set up a grading system that aligns with your course goals, ensuring effective communication of student progress and areas for improvement. You can customize how grades are displayed, updated, and managed, creating a seamless and efficient grading experience.
 
 
 
 Grades is grading guide 2 of 3.
 Things to consider
 Before setting up your Brightspace grade book, refer to the course’s Education Council approved grade allocation. Use the grade allocation to guide your creation of grade categories.
 Grading serves a dual purpose: providing feedback and evaluating student work. Through effective grading, you communicate students’ performance, highlight their progress, and identify areas needing improvement to achieve course goals. In addition to marks, plan how you will provide feedback on graded items. Consider using rubrics, comments, and other feedback tools to give constructive and meaningful feedback.
 Overview of the Grades Tool
 The Brightspace Grades tool offers a robust suite of features designed to create and manage grades. With its flexible and powerful capabilities, Brightspace reduces technical barriers and empowers you to teach and assess in a way that aligns with your course learning outcomes.
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://pressbooks.bccampus.ca/langaraquickguides/?p=1452#oembed-1 
 
 Setting Up Your Brightspace Gradebook for Student Success
 A well-structured gradebook helps students track their progress and understand how individual assessments contribute to their overall grade. To ensure transparency, students should have access to their overall progress at various points throughout the term (e.g., before the withdrawal deadline, after substantial assessments, etc.).
 In Brightspace, you can display overall progress in two ways:
 Release Final Calculated Grade
 This option displays overall progress to students which automatically updates as students complete assessments throughout the term.
 Pros: provides real-time view of overall progress when released.
 Cons: requires ungraded items to be treated as 0* in order for accurate display of overall progress. This means overall grade is additive as assessments are completed. Students will need a clear explanation on the gradebook set up.
 
 Milestone Grade Calculations
 This approach requires you to manually set up grade calculations at key points in the term, helping students understand their performance at designated checkpoints.
 Pros: allows ungraded items to be dropped* so it will display student progress in relation to the number of assessments completed.
 Cons: each milestone grade calculation needs to be manually set up.
 
 
 *Refer to cautionary notes regarding Grade Calculations
 Essential Steps to Setting Up Your Grade Book
 Before you Begin
  Have your course syllabus, assessment list, and grading structure ready. Plan to set up your complete gradebook at the start of term to ensure accurate grade calculations for students. If assessment items are missing, students may see misleading calculations of their overall progress—grades may appear artificially higher, lower, or incomplete depending on the settings used. This can lead to student confusion about their actual standing in the course.
 
 	Complete the Grades Setup Wizard.
 	Create grades categories.
 	Create grade items.
 	Associate activities with grade items.
 
 Complete the Setup Wizard
 You can configure the setup of your gradebook by clicking My Tools > Grades.[image: ]
 The Setup Wizard is the first step in creating your gradebook. If this is your first-time accessing Grades in your sandbox or course, you will automatically be directed to the seven-step Setup Wizard. You can return to the Setup Wizard at any time through the Setup Wizard tab. Under the Setup Wizard tab, scroll down and click Start to begin setup.
 The Setup Wizard allows you to:
 	Establish a grading system
 	Determine your final calculation method
 	Identify what to do with ungraded items
 	Choose grade scheme
 	Set Display settings
 
 [image: ]
 Read through the Understanding the Grades Setup Wizard page for our recommended settings and additional information on how each option impacts the student experience.
 To set up your gradebook and release final calculated grade: 	In the Grades Setup Wizard, choose: 	Weighted grading system
 	Release Calculated Final Grade
 	Treat ungraded items as 0 and automatically keep final grade updated
 
 
 	Follow instructions to manually release Final Calculated Grades.
 
  To set up your gradebook and create milestone grade items: 	In the Grade Setup Wizard, choose: 	Weighted grading system
 	Release Adjusted Final Grade
 	Automatically keep final grade updated
 
 
 	Follow instructions to manually create milestone grade items at specific intervals throughout your course.
 
 
  Gradebook Categories and Items
 Under the Manage Grades tab, you can create Grade Book Categories and Items.
 Using Categories in your grade book allows you to organize your items under category headings. For example, you can create category headings to organize Assignments, Quizzes, Case Studies, Participation, and Discussions.
 A category can consist of one or more grade items. When graded items are grouped together in a category, you can distribute the category weight equally across all grade items and drop the highest or lowest item in the group. If you decide to manually distribute the category weight toward each grade item, you will need to determine the portion of the category grade that will go towards each item. Use the formula below to help you determine this:
 [image: grade item weightgrade category weight×100]
 
 Example
 If a grade item is worth 5% of the overall course grade and the category weight is 20% of the overall grade, the manually weighted item is worth: 5/20 x 100 = 25% of the category weight
 
 For a weighted grade book system, categories are required and used to identify weighted areas.
 To create grade categories: From the Manage Grades tab,
 	Click on New and select Category.
 	Give your category a name and select the options that are relevant for the category.
 	Click Save and Close.
 
 Watch the following video to learn how to create grade categories.
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://pressbooks.bccampus.ca/langaraquickguides/?p=1452#oembed-2 
 
 Warning: Do not create a category to organize bonus items. Brightspace calculates subtotals for categories, in the case of a bonus item category the subtotal denominator would be 0 and division by 0 is an arbitrary math violation.
 See EdTech’s Bonus Marks resource to learn how to assign bonus marks and create a bonus grade item.
 
  To create grade items: From the Manage Grades tab,
 	Click on New and select Category.
 	On the New Item page, choose a Grade Item Type from the following: 	Numeric: Grade users by assigning a value out of a specified total number of points.
 	Selectbox: Grade users by selecting the grade scheme level that best matches their achievement. Selectbox type grade items cannot be created until at least one org unit grade scheme has been created.
 Note: Numeric and Selectbox are the only grade items that will support associations for grading and actively contribute to grade book calculations.
 	Pass/Fail: Grade users using a simple pass or fail grade scheme.
 	Formula: Automatically grade users using a custom formula based on their achievement for other grade items.
 	Calculated: Calculate users’ cumulative achievement across multiple grade items.
 	Text: Provide comments in the grade book that are not calculated in the final grade.
 
 
 	In the Properties tab, enter the details for your grade item.
 Note: The fields in Properties will vary based on your chosen Grade Item Type. To learn more about a particular field in Properties, click the Get help on (? icon) beside the field.
 	In the Restrictions tab, enter the following information: 	Hide from users: Hide restrictions from learners.
 	Has Start Date: Set a Start Date for the grade category.
 	Has End Date: Set an End Date for the grade category.
 	Display In Calendar: Display Start and End Dates in the course Calendar.
 	Release Conditions: You can Attach Existing conditions or Create and Attach conditions.
 
 
 	Click Save and Close.
 
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://pressbooks.bccampus.ca/langaraquickguides/?p=1452#oembed-3 
 
  Associate Activities with Grade Items
 The final stage in setting up your grade book and having it populate with student marks is to associate graded activities with the grade items in your grade book. The following videos shows you how its done.
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://pressbooks.bccampus.ca/langaraquickguides/?p=1452#oembed-4 
 
 Now that you’ve setup your grade book you can learn more about managing your grade book and grading assessments.
 More About Grades
 Learn how to
 	Adjust and release final grades
 	Drop lowest item score from a grade category
 	Add bonus grades
 
 Next Steps
  	Enter and preview grades
 	Grade assignments and provide feedback
 	Grade quizzes
 	Adjust final grades
 
 
 
 
 Contact edtech@langara.ca for more information.
 [image: ]
 If you are a Langara employee, self-register for Essentials to Excellence: A Brightspace Companion for Instructors. This Brightspace course compliments the technical instructions found here with use cases, examples, and advice.
 
	

			
			


		
	
		
			
	
		

		

								

	
				Adding Bonus Grades
 [image: Brightspace logo]
 In certain instances, you might want to award bonus marks to students for an assessment or make an entire activity a bonus item in the grade book. These situations can be accommodated in Brightspace.
 
 
 Adding Bonus Grades is grading guide 3 of 3.
 Enable Bonus Marks for a Grade Item
 In the instance where you would like students to be able to exceed the maximum number of points on an assessment like an assignment or quiz, you will need to ensure you check off Can Exceed for the grade book grade item.
 Step 1: Go to My Tools > Grades > Manage Grades.
 	If you have created this grade item already, click the caret next to the grade item you want to exceed 100% and select Edit.
 	If you have not created the grade item yet, select New > Item.
 
 Step 2: Under the Grading section, select the Can Exceed checkbox.
 [image: ]
 Step 3: Click Save and Close.
 Create a Bonus Grade Item
 In the instance where you want to create a bonus item that does not impact the Final Calculated Grade if students choose not to complete the item, you will need to ensure you check off Bonus for the grade item.
 Step 1: Go to My Tools > Grades > Manage Grades
 	If you have created this grade item already, click the caret next to the grade item you want to exceed 100% and select Edit.
 	If you have not created the grade item yet, select New > Item.
 
 Step 2: Under the Grading section, select the Bonus checkbox.
 [image: ]
 Step 3: Click Save and Close.
 On the Manage Grades, you will see a star beside your grade item, indicating that this item is bonus.
 [image: ]
 Important
 [image: ]
 Bonus items are not included in the maximum points for a category or final grade. They are added on top of the calculated grade. If the bonus grade item is within a category and you want the category to exceed 100%, see Enable a Grade category to Exceed 100% below. If you want the bonus grade item to allow the final calculated to exceed 100%, see Enable Final Grade to Exceed 100%.
 
 
 Enable Category to Exceed 100%
 In the instance where you have awarded bonus marks to a grade item or made a bonus grade item and want the category that the item is in to exceed the the maximum category weight, you need to ensure you check off Allow category grade to exceed category weight.
 Step 1: Go to My Tools > Grades > Manage Grades.
 	If you have created the Category, click the caret next to the Category you want to exceed 100% and select Edit.
 	If you have not created the grade item yet, select New > Category.
 
 Step 2: Under the Grading section, select the Allow category grade to exceed category weight checkbox.
 [image: ]
 Step 3: Click Save and Close.
 Enable the Final Calculated Grade to Exceed 100%
 In the instance where you would like the final calculated grade to exceed 100%, you need to ensure you check off the Can Exceed box in the Final Calculated Grade.
 Step 1: Go to My Tools > Grades > Manage Grades.
 Step 2: Click the caret next to Final Calculated Grade and select Edit.
 [image: ]
 Step 3: Under Grading, select Can Exceed.
 [image: ]
 Step 4: Click Save and Close.
 
 Contact edtech@langara.ca for more information.
 [image: ]
 If you are a Langara employee, self-register for Essentials to Excellence: A Brightspace Companion for Instructors. This Brightspace course compliments the technical instructions found here with use cases, examples, and advice.
 
	

			
			


		
	
		
			
	
		

		

								

	
				Assignments
 [image: Brightspace logo]The Brightspace Assignments tool provides the functionality for creating and editing assignments, setting up submission details, associating rubrics, viewing and grading submissions, and providing feedback.
 
 Things to consider
 Before setting up an Assignment Submission Folder in Langara’s instance of Brightspace, consider preparing the following:
 Rubric A well-designed rubric enhances consistency in grading and clarifies grading criteria and performance expectations for students. Brightspace allows you to create a grading rubric directly within the system, which can be linked to assignments, grade items, or other assessed elements. It is advisable to design your analytic or holistic rubric on paper first and then manually input the criteria into Brightspace. Please note that Brightspace does not support direct uploads of rubrics from Excel or other tabular formats.
  Assignment Instructions Clearly written, detailed instructions are crucial for guiding students. Consider drafting and reviewing these instructions to ensure clarity and comprehensiveness before attaching them to the assignment. Remember that students can’t ask you follow-up questions and receive an immediate answer as they might do at the end of an in-person class. They are receiving a lot of written instructions from their courses and they may become overwhelmed when trying to read through wordy paragraphs. Learn more about the importance of clear instructions.
 Ensure instructions come before an interaction, not after it. Add instructions in the module introduction as well as the individual tools and pages where activities occur. Ensure students know what to do, how to do it, and where to submit it.
 Assignment instructions should include:
 	The due date
 	Purpose of assignment and connection to course learning outcomes
 	Step-by-step instructions 	Including specific submission requirements such as what, how, and where to submit
 	Guidance on specific required technology
 
 
 	Grading details, rubric, or other evaluation criteria.
 	Feedback methods 	Brightspace offers several tools for giving feedback, including inline comments, attached files, or video or audio feedback. Setting expectations for feedback can improve the learning experience by reducing uncertainty.
 
 
 
 Instructions helps ensure that both students and graders clearly understand the expectations.
  Grade Item Prepare a Grade Item in the Brightspace Gradebook for the assignment beforehand. This item can then be connected to the assignment via the Grades tool, streamlining the grading process.
  Release Conditions Consider setting release conditions to control access to the assignment. For instance, you might restrict access until a specific date or until students complete a prerequisite task, such as a quiz or discussion post. It’s practical to establish these conditions or complete these prerequisite tasks before creating the assignment.
  Group Assignments For collaborative assignments, ensure that the necessary groups are already formed in Brightspace prior to assignment setup.
  Special Access This feature allows you to provide exceptions or special access to certain students or groups. For example, you might extend a submission deadline for students requiring additional support or for those undertaking tasks that go beyond the initial assignment parameters.
  Categories Categories enable you to manage related assignments and organize them into groupings. For example, consider using separate categories for assignments and major projects.
  By organizing these components in advance, you can streamline the setup process and enhance the educational experience for both instructors and students.
 To create an assignment in Brightspace:
 Step 1:
 Navigate to Course Materials > Content.
 Our Recommendation
 [image: ]
 Create assessments directly in Content. Why? When you create an assignment via Tools, students will only be able to access the assignment through the Tools menu in your course navbar. The assignment will not be visible in the content area of your course page unless you add it to a module/submodule using the existing activities menu.
 
 
 Step 2:
 From the Table of Contents, select the module/week section where you’d like to add the assignment > Click Upload/Create button > New Assignment.
 [image: ]
 
 Step 3:
 Give the assignment a title.
 [image: ]
 
 
 
 Step 4:
 Set the grade points for the assignment in the Grade Out Of box.
 [image: ]
 An In Grades drop-down menu will appear where you can select Choose from Grades to add an item to the course gradebook. 
 Choose from grades options: 	In Gradebook will be selected by default, meaning a new assignment grade item will be added to your gradebook. If you have set up categories in the gradebook, you will be able to select it from the Grade Category dropdown menu.
 	Edit or Link to Existing allows you to link your assignment to a grade item you have already added to your gradebook. If you have already created a grade item for your assignment, you can select it from the drop-down menu.
 	Not in Gradebook – Choose this option if you do not want your assignment to appear in the gradebook.
 	Reset to Ungraded – If you do not want to create a graded assignment, you can reset to ungraded using this option.
 
  Step 5:
 Provide a detailed description of the assignment. You can format the text and include links, images, or videos.
 [image: ]
 
 Step 6:
 Set the due date and availability dates.
 [image: ]
 
 
 
 Step 7:
 Set submission options on the Submissions & Completion menu.
 	Organize Assignments by choosing a Category.
 	Choose the Submission Type (e.g., file submission, text submission, etc.). Use text submission for a written submission directly in the Brightspace Assignment folder and video or audio submissions using Mediaspace.
 	Decide if the assignment will be an individual task or a group assignment.
 	Specify the Number of Allowed Attempts.
 
 [image: Select submission options on the Submission & Completion menu.]
 
 Step 8:
 Attach a rubric on the Evaluation and Feedback menu, if applicable.
 [image: Set the evaluation options in the Evaluation & Feedback menu.]
 
 
 
 Further Resources
 Learn how to
 	Evaluate assignments using the Assignments tool
 	Configure anonymous marking
 	Support student audio and video assignment submissions
 	Preview an assignment as a student
 
 
 Contact edtech@langara.ca for more information.
 [image: ]
 If you are a Langara employee, self-register for Essentials to Excellence: A Brightspace Companion for Instructors. This Brightspace course compliments the technical instructions found here with use cases, examples, and advice.
 
	

			
			


		
	
		
			
	
		

		

								

	
				Quizzes — Using the Question Library
 [image: ]
 The Question Library serves as a central repository for storing and organizing quiz questions that you can reuse across your course. Think of it as your personal question bank—you can create sections (folders) to organize questions by topic or type, making them easy to locate when building quizzes, surveys, and self-assessments.
 
 
 
 Quizzes — Using the Question Library is Quizzes guide 1 of 2.
 Recommended Best Practice
 [image: ]
 Create Brightspace quizzes in the following order:
 	Add sections and subsections (folders and subfolders) to a course’s Question Library to organize questions
 	Create or import questions in the sections and subsections
 	 Import questions into a quiz from the Question Library
 
 
 
 Benefits of using the Question Library
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://pressbooks.bccampus.ca/langaraquickguides/?p=1354#oembed-1 
 
 Accessing the Question Library
 To access the Question Library, click Assessments > Quizzes, then click on the Question Library tab.
 [image: ]
 Step-by-step Instructions
 Step 1: Create a new section
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://pressbooks.bccampus.ca/langaraquickguides/?p=1354#oembed-2 
 
 
 
 Step 2: Create or Import Question in the Sections
 	Click on the name of the section or subsection to which you would like to create the questions.
 	Click New, then select the desired question type from the drop-down menu.
 
 
 Watch the following video for an overview of the question types available in Brightspace.
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://pressbooks.bccampus.ca/langaraquickguides/?p=1354#oembed-3 
 
 For step-by-step help creating each available question type, visit the D2L page on creating questions.
 To learn about the benefits and challenges of each question type as well pedagogical tips, see Memorial University’s resource on Question Types in Brightspace.
 To import questions to the Question Library from an existing quiz: It’s important to understand that the Question Library stores questions separately from the quizzes in D2L Brightspace. Questions are not automatically copied to the Question Library when they are imported to or created in a quiz. Therefore, it’s a good idea to import any questions to the Question Library if they are not already there so that you have a backup in case a quiz is deleted.
 	Click on the name of the section or subsection to which you would like to import the questions.
 	Click Import > Browse Existing Questions.
 	Change the Source to the quiz you would like to import the questions from.
 	The list of questions will appear on the page. Check the box next to the questions or sections you would like to import, or check the box at the top to select them all.
 	Click Import when you have finished selecting your questions.
 	Repeat steps 1-5 until you have finished copying your quiz questions into the Question Library.
 	Check to make sure that the sections and questions are organized in the Question Library as you would like them and move sections/questions as needed.
 	Click Done Editing Questions.
 
  To import questions from another course’s Question Library: Watch the following video to find out how to use Import/Export/Copy Components to import questions from another course.
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://pressbooks.bccampus.ca/langaraquickguides/?p=1354#oembed-4 
 
  Step 3: Import Questions into a Quiz from the Question Library
 [image: ]
 Now that you have a bank of questions to draw from, move to the next page to learn how to create a quiz with the appropriate settings and quickly populate questions from the Question Library.
 
 
 
 
 Contact edtech@langara.ca for more information.
 [image: ]
 If you are a Langara employee, self-register for Essentials to Excellence: A Brightspace Companion for Instructors. This Brightspace course compliments the technical instructions found here with use cases, examples, and advice.
 
	

			
			


		
	
		
			
	
		

		

								

	
				Quizzes — Creating a Quiz
 [image: ] Brightspace’s quiz tool allows you to make online quizzes, ranging from informal knowledge checks to high stakes exams. The quiz tool is robust and this quick start guide will only cover basic functions. Please contact Langara EdTech for more in-depth support.
 
 
 On this page:
 	Quiz Details
 	Link to Grade Book
 	Add Questions
 	Verify Total Points Value
 	Specify Dates
 	Set a Time Limit
 	Specify Paging
 	Choose a Category
 	Specify Evaluation & Feedback Settings
 	Save & Preview
 
 Quizzes — Creating a Quiz is Quizzes guide 2 of 2.
 Getting Started
 To see a quick overview of quiz creation, please watch the short video below.
 Note: We highly recommend using the Question Library to create and organize questions before importing them into a quiz. Please see Using the Question Library Quick Start Guide.
 
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://pressbooks.bccampus.ca/langaraquickguides/?p=715#oembed-1 
 
 Accessing the Quiz Tool
 Go to Course Materials > Content > Upload/Create > New Quiz
 [image: ]We recommend creating quizzes directly in Content. Why? When you create a quiz via the Manage Quizzes page, students will only be able to access the quiz through the Tools menu in your course navbar. The quiz will not be visible in the content area of your course page unless you add it to a module/submodule using the existing activities menu.
 
 Step 1: Enter Quiz Details
 When creating a new quiz, you will start by adding quiz details.
 [image: Create quiz page with title, description, and save button outlined.]
 	Title: this is a mandatory field (hint: give all your quizzes descriptive titles that will clearly identify them for both you and your students)
 	Description: students will see the description on the Start Quiz page so this is where to include any instructions you want students to see immediately before they begin the quiz (hint: making the instructions a larger font and a different colour, will help instructions to stand out on the screen)
 	Save: as you build your quiz and adjust the settings, don’t forget to Save regularly
 
 Step 2: Link to Grade Book
 All quizzes that contribute toward the final grade should have an associated item in the grade book. If the grade book has already been set up, connecting the quiz to the grade book is straightforward.
 To connect a quiz to the grade book, go to the Grade Out Of settings, click on the drop-down for the Grade Book association, and select Edit or Link to Existing.
 [image: Grade book association option dropdown.]
 On the pop-up screen, click the radio button Link to an existing grade item and select the grade item for this quiz from the dropdown. Then click OK.
 [image: Link to an existing grade item with quiz grade item, "Midterm" selected.]
 Step 3: Add Questions
 To add questions to the quiz, click on:
 	Add Existing dropdown (below the Description field)
 	Browse Question Library
 
 [image: Add existing questions with Browse Question Library selected.]
 From the question library, you will have the following options:
 	Select entire sections (this will import any description, including text or media, that has been added to the section, as well as any questions contained within that section); or
 	Select individual questions (sections can be expanded by clicking the arrow to the left of the checkbox; this will allow you to select individual questions within a section).
 
 Once the selections are made, click Import.
 [image: selecting questions from the Question Library to import into a quiz]
 Step 4: Verify Total Points Value
 Quiz is in Grade Book
 Once all questions have been added, adjust the points total in the Grade Out Of box.
 If the quiz has been linked to the grade book, the total number of points will be automatically taken from the ‘weighting’ of the grade item towards the final grade (e.g. if the quiz is worth 10% of the final grade, this score will default to 10 points).
 [image: Grade out of 10 points.]
 However, once all of the questions have been added, the total points should be manually adjusted to align with the total points value of the questions in the quiz.
 [image: manually adjusted total points aligned with questions point value total]
 Quiz is Not in Grade Book
 If the quiz is not connected to the grade book, the points will be automatically taken directly from the total value of the questions added to the quiz and will not be editable.
 [image: uneditable points value field when quiz is not connected to grade book]
 Step 5: Specify Dates
 See also Dates, Deadlines, and Availability Quick Guide.
 You have two options for adding deadlines: 1) Due Date; and 2) Availability Dates
 [image: Due Dates and Availability Dates on quiz setup page.]
 Due Dates
 Use a Due Date if the quiz is lower stakes and you would like it completed by a certain time, but don’t want to stop a student from taking it past the deadline (quizzes submitted past the deadline will be accepted but marked as late).
 [image: Due Date]
 
 Availability Dates
 Use Availability Dates if the quiz is higher stakes and you only want it accessible for a specified period. For example, you can specify that the quiz must be started between 3:00 pm and 3:20 pm on October 21. At the end of the availability window (i.e. Oct 21 at 3:20pm), the student will no longer be able to begin the quiz.
 [image: Availability dates of start on October 21, 2024 at 3:00 pm and end on October 21, 2024 at 3:20 pm.]
 
 
 
 Due Dates vs Availability Dates
  	Although you can add both a due date and an end date, we recommend using one or the other to avoid confusing students. End dates will override due dates.
 	Due dates will automatically be added to the course calendar. If using Availability Dates, click the box below the dates to ensure that availability dates are added to the calendar (this is not automatic).
 	Availability windows may or may not affect the length of time the student has to complete the quiz once they’ve started. See Time Limits below to learn more about synchronous and asynchronous time limits.
 
 
 
 Step 6: Set a Time Limit
 Higher stakes quizzes generally have a time limit. This is set in the Timing & Display tab.
 [image: timing and display menu to specify a time limit for a quiz]
 The default is for quizzes to be auto-submitted for grading once the time limit has been reached.
 [image: ]
 Synchronous Versus Asynchronous Time Limits
 Whether an instructor wants to use a synchronous or asynchronous time limit depends on whether the quiz is designed to have a synchronous start for all students or not. The default setting is asynchronous, but this can be changed by clicking the Timer Settings button.
 [image: Timer Settings to change from an asynchronous to synchronous time limit.]
  
 Synchronous Time Limit
 Use a synchronous time limit when you want the quiz timer to begin on the start date/time and stop at the time limit for all learners. Learners who start late (but within the availability window), will be able to take the quiz but they will have less time to complete it (e.g. if they begin a 60 minute quiz 10 minutes after the start time, they will only have 50 minutes to complete it).
 [image: synchronous quiz timing for Brighstpace quizzes]
 For students taking a synchronous quiz, the Start Quiz button is disabled until the start time. A countdown timer will be visible on the Start Quiz page to indicate the remaining time before the quiz becomes available.
 [image: countdown on the Start Quiz page]
 
 Asynchronous Time Limit
 If an instructor wants the students to be able to begin the quiz at any time within the availability window and have the full time limit to complete it, use the asynchronous option (this is the default). This quiz setting is commonly used in fully asynchronous courses with students who might have varied schedules, as well as for lower stakes quizzes.
 [image: Brightspace quizzes asynchronous quiz settings]
 Students who start an asynchronous quiz any time within the availability window — even 1 minute before the end date — will have the full time limit to complete the quiz.
 
 
 
 Recap: Availability Window vs Time Limit
  Availability window (Start/End Dates): the time period during which a student can begin a quiz
 Time Limit: the amount of time the student has to complete a quiz once they’ve started it
 
 
 
 Step 7: Specify Paging
 Specify how many questions the students will see on each page of the quiz using the Paging drop-down in the Timing & Display tab.
 [image: Paging default setting: all questions displayed together]
 Decide on the number of questions to display per page and whether or not you will allow them to navigate backwards to previous pages.
 [image: Brightspace Quizzes paging options: 5 questions per page with no going back to previous pages]
 [image: ]When deciding on the number of questions to display per page, consider a balance between exam integrity and exam anxiety. Allowing students to see all exam questions at once will increase opportunities for academic misconduct, but allowing students to see only one question per page often increases exam anxiety (and increased anxiety is a risk factor for students to commit academic misconduct).
 Consider a balanced approach:
 	allow students to see several (but not all) questions on each page as this can reduce anxiety by allowing them some choice in which questions to answer first
 	click the box Prevent going back to previous pages to prevent students from having unlimited opportunities to revisit previous answers
 
 
 Step 8: Set Category
 Choose a category to organize Quizzes by type, topic, or other grouping.
 Step 9: Specify Evaluation & Feedback Settings
 The default settings under Evaluation & Feedback are set to automatically publish the Attempt grade (score) when the quiz is submitted. It is important to consider whether or not the quiz can be reliably auto-graded when it comes to these settings.
 Consider Whether to Auto-Publish Results
 If the quiz consists solely of questions that can be reliably auto-graded (e.g. multiple choice, True/False, etc.), there are no issues with result accuracy if you publish the students’ scores upon submission (the default setting).
 [image: Auto-publish Brightspace quiz results immediatelyl upon completion]
 However, auto-publish is not recommended if there are any questions in the quiz which require students to type answers as these will require review (e.g. short answer, fill-in-the blank, etc.) or manual grading (written response).  Unclick the box Auto-publish attempt results immediately upon completion if there are any quiz questions requiring typed answers.
 [image: Unchecked "Auto-publish results immediately upon completion."]
 Synchronize to Grade Book
 If you linked the quiz to your grade book, make sure you select the option to Synchronize to grade book on publish or you will need to manually push the scores to the grade book.
 [image: Option to synchronize scores to grade book when published.]
 Show Feedback and/or Questions
 Students will only see their published score under the default settings. If you want them to see how they did on specific questions, any feedback you added while grading, and/or the correct answers, you will need to change the display settings. For help with this, please reach out to EdTech.
 Step 10: Save & Preview
 As a final step, make sure that you:
 	Save your quiz
 	Preview your quiz (the Quiz preview replicates the student experience exactly)
 
 [image: Save and Preview buttons in Brightspace quiz creation.]
  
 [image: ] This quick guide is only meant to introduce the basics. If the information you were hoping to find is not part of this guide, please contact EdTech. Additional topics include adding release conditions, allowing special access, scheduling custom result views, and many other topics.
 
 
 
 Contact edtech@langara.ca for more information.
 [image: ]
 If you are a Langara employee, self-register for Essentials to Excellence: A Brightspace Companion for Instructors. This Brightspace course compliments the technical instructions found here with use cases, examples, and advice.
 
	

			
			


		
	
		
			
	
		

		

								

	
				Discussions
 [image: Brightspace logo]
 Discussions are an effective way to stimulate student engagement and collaboration, foster a sense of community, offer feedback, and help students explore the course content. Asynchronous discussions encourage deeper reflection and critical thinking, enhance student exposure to various course materials, present students with diverse perspectives, and enable instructors to assess student learning.
 
 
 Discussions is Discussions guide 1 of 2.
 Setting up a discussion forum, topic, and thread
 D2L discussions are organized into the following:
 	Forum: broad categories for discussion
 	Topic: specific discussions within the forum
 	Thread: student response within the topic
 
 Adding a Topic and Forum
 [image: ]
 	Navigate to Course Materials > Content.
 	From the Table of Contents, select the module where you’d like to add the Discussion.
 	Click Upload/Create > New Discussion if you are creating a new discussion. If your Discussion already exists, you can click Existing Activities > Discussion and select the Forum/Topic you wish to add.
 	Give your new topic a Topic Title and add instructions for your students in the Description textbox. You can set availability dates, release conditions, and group restrictions to your topic. You can also add rubrics and evaluate topics, if you provide a Grade Out Of score.
 [image: ]
 	Click Change Forum to add a new Forum or link to an existing Forum.
 [image: ]
 	If you are creating a new forum, provide a Forum Title or if a forum exists, choose it from the dropdown. Click Apply Changes.
 [image: ]
 Note: Forums are used to group discussion topics. Users cannot post to Forums directly; posting requires a topic to be created first.
 	At the bottom of the screen, toggle the topic from Hidden to Visible.
 	Click Save and Close when done.
 
 Group Discussions As part of the Groups creation process, you have the option to create associated Discussions at the same time. However, it’s also possible to create Discussions and Groups separately and then connect them later.
 If you want to link a Discussion with Groups, you can link them in the Topic settings.
 	Go to Communication > Discussions
 	Find the name of the Discussion topic, click the arrow to show the drop-down, and select Edit Topic from the options
 [image: ]
 	Expand the Availability Date & Conditions settings on the right
 	Click on Manage Restrictions
 [image: ]
 
 To manage restrictions, take the following steps:
 	Group and Section Restrictions: Select Restrict topic and separate threads
 	Select who will see this topic: Select the Group you want to link to in the drop-down options
 	Click Add
 
  Editing Topics
 If you need to make any updates or changes to a topic, navigate to Communication > Discussions. Expand the dropdown menu beside the topic and select Edit Topic.
 [image: ]
 
 Adding Additional Topics
 Additional topics can be added to already created forums. To do this, expand the dropdown menu in the discussion forum you wish to add another topic and click Add Topic.
 [image: ]
 
 
 Adding a Thread/Post
 	In the topic where you want to add a thread, click Start a New Thread.
 [image: ]
 
 
 	Add a title to the thread and discussion into the textbox. In Brightspace Discussions, you are not limited to posting text. You can post video, audio, images, etc. Consider giving students options in their modes of expression.[image: ]
 	Click Post.
 
 
 
 Further Resources
 	Asynchronous discussions – how and why
 	Effective Practices for Teaching with Online Discussions
 	Facilitating Discussions in D2L
 	Online Discussions: Tips for Instructors
 	Online Discussions: Tips for Students
 	Online Discussion Questions That Work
 
 [image: ]
 Discussions can also be used as an assessment. Move to the next quick guide on assessing topics to learn about easy grading of discussions.
 
 
 Contact edtech@langara.ca for more information.
 [image: ]
 If you are a Langara employee, self-register for Essentials to Excellence: A Brightspace Companion for Instructors. This Brightspace course compliments the technical instructions found here with use cases, examples, and advice.
 
	

			
			


		
	
		
			
	
		

		

								

	
				Rubrics
 [image: Brightspace logo]
 Rubrics in Brightspace are powerful tools for evaluating student work consistently and transparently. They provide clear grading criteria, making assessments more objective and consistent while offering students valuable feedback on their performance. Rubrics help students better understand expectations and how their work will be evaluated. Rubrics also aid instructors by creating an efficient, repeatable marking system. This guide will help you create, attach, and use Brightspace rubrics effectively.
 
 
 Before you begin creating rubrics, it’s important to understand the two main types of rubrics available and how they can be used to align with your teaching goals.
 Types of Rubrics
 Analytic Rubrics 	Description: Analytic rubrics evaluate student work based on multiple criteria, with each criterion assessed across defined levels of achievement. This type provides detailed feedback on specific aspects of a student’s work.
 	Structure: Each row represents a criterion (e.g., clarity, organization, depth of analysis), and each column represents a level of achievement (e.g., Exemplary, Proficient, Developing, Beginning).
 	Use Case: Ideal for assignments where multiple components are being assessed, such as essays, projects, or presentations.
 
 [image: Example analytic rubric with four levels and two criteria.]
  Holistic Rubrics 	Description: Holistic rubrics provide a single overall score for student work, based on an overall impression of performance. Feedback is less detailed but faster to apply.
 	Structure: The rubric consists of descriptive levels of performance, each with a point value.
 	Use Case: Best suited for quick assessments or tasks where a single criterion captures overall performance, such as participation or creative expression.
 
 [image: Example holistic rubric scored using percentages.]
  Choosing the Right Rubric Type
 	Use analytic rubrics for detailed, criterion-based feedback that guides students in improving specific aspects of their work.
 	Use holistic rubrics for quick assessments or when you want to emphasize an overall impression rather than dissecting individual components.
 
 Getting Started with Rubrics in Brightspace
 Step 1: Create a New Rubric
 	Access the Rubrics Tool: 	From your course navigation bar, go to Course Admin > Rubrics.
 
 
 	Create a New Rubric: 	Click New Rubric.
 
 
 	Enter Rubric Details: 	Provide a Name for your rubric.
 	Choose the appropriate Status (e.g., Published or Draft).
 	Set the Rubric Type: 	Analytic: Multiple criteria with different levels of achievement.
 	Holistic: A single, overall criterion for evaluation.
 
 
 
 
 	Add Criteria and Levels: 	Use the default criteria or click Add Criterion to create new ones.
 	Define levels (e.g., Exemplary, Proficient, Developing, Beginning) and their associated point values.
 
 
 
 Watch the following video to see how to create a new rubric and learn some quick tips.
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://pressbooks.bccampus.ca/langaraquickguides/?p=2072#oembed-1 
 
 
 Step 2: Attach a Rubric to an Activity
 	Navigate to the Activity: 	Open the assignment, discussion, or quiz where you want to attach the rubric.
 
 
 	Add the Rubric: 	In the activity settings, locate the Evaluation & Feedback section.
 	Click Add Rubric and select the rubric.
 
 
 	Save Changes: 	Click Save and Close to attach the rubric to the activity.
 
 
 
 
 Step 3: Assess an Activity with a Rubric
 Watch the following video to learn how to how to grade using rubrics.
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://pressbooks.bccampus.ca/langaraquickguides/?p=2072#oembed-2 
 
 Additional Information
 Rubric Settings: Brightspace rubrics can be used for scoring (with points) or feedback-only purposes. Choose the option that aligns with your grading approach.
 Visibility to Students: You can decide whether to make rubrics visible to students before or after grading. Sharing rubrics in advance helps clarify expectations and supports self-assessment.
 Reusability: Rubrics can be copied and adapted for multiple assignments or courses, saving time and ensuring consistency.
 
 Contact edtech@langara.ca for more information.
 [image: ]
 If you are a Langara employee, self-register for Essentials to Excellence: A Brightspace Companion for Instructors. This Brightspace course compliments the technical instructions found here with use cases, examples, and advice.
 
	

			
			


		
	
		
			
	
		

		

								

	
				Checklists
 [image: ]
 Checklists are primarily used as a tool for students to help track their progress within a module. Checklists support learners in completing learning activities, assessments and for assignment preparation, or to simply help students remain on top of their learning and help them stay organized.
 
 
 Building a Checklist
 Step 1:
 From the toolbar in your course, select Course Admin > Checklists.
 [image: ]
 
 Step 2:
 Select New Checklist.
 [image: ]
 
 
 
 Step 3:
 Name your checklist, add a description as needed, and click Save. Note: You have the option to check “Open this checklist in a new window when viewed”.
 [image: ]
 
 Step 4:
 Click New Category to add a category to your checklist.
 [image: ]
 
 
 Step 5:
 Name your category and provide a description as needed. Click Save. For example, if you have weekly readings and assignments, these would be your categories.
 [image: ]
 
 Step 6:
 Click New Items to add individual items to your categories. Choose from existing categories in the dropdown.
 [image: ]
 
 
 
 Step 7:
 Name your item and add a description as needed.
 Note: You have the option to include a Due Date for the item. If desired, check the box and set the due date and time. If you use due date, we recommend checking the box “Display in Calendar” as well.
 [image: ]
 
 Step 8:
 Click Save. Repeat as needed.
 When you’ve completed your checklist click Save and Close. Preview your checklist by expanding the dropdown beside your checklist and clicking Preview in a new window.
 [image: ]
 
 
 
 [image: ] Checklists need to be added to a relevant module. Why? When a checklist is created, it is not visible to students unless it is added to a module via Course Materials > Content. Follow the instructions below to add a Checklist to Course Materials.
 
 
 Adding Checklists to Content Modules
 Step 1:
 Go to Course Materials > Content.
 Step 2:
 In the module you wish to add the checklist, expand the Existing Activities dropdown and click Checklist.
 [image: ]
 
 Step 3:
 In the new window that appears, choose the checklist you created.
 [image: ]
 
 
 
 Contact edtech@langara.ca for more information.
 [image: ]
 If you are a Langara employee, self-register for Essentials to Excellence: A Brightspace Companion for Instructors. This Brightspace course compliments the technical instructions found here with use cases, examples, and advice.
 
 
	

			
			


		
	
		
			
	
		

		

								

	
				Dates, Deadlines, and Availability
 [image: Brightspace logo]
 Adding dates to items in Brightspace is crucial for enhancing organization and communication within the course. Dates benefit both students and instructors by providing a clear roadmap of the timeline and sequence of course content and activities, thereby aiding effective time management and accountability.
 
 
 Important: If your content, activity, or assessment is Hidden to students, as indicated by an icon with a line over an eye [image: ], nothing will be visible to students regardless of date, deadline, or availability settings.
 In this guide, you will find comprehensive information on:
 	Brightspace Date Terminology: Understand key terms such as due dates, availability, start dates, end dates, special access, and visibility settings.
 	Visibility Settings for Discussions: Learn how to manage visibility to keep conversations organized and accessible.
 	Visibility Settings for Assignments: Understand how to control student access to assignment submissions.
 	Due Dates and Availability Dates for Assignments and Quizzes: Discover best practices for setting deadlines and availability windows to enhance time management and accountability.
 	Answers to Frequently Asked Questions: Find quick solutions to common issues related to dates and availability in Brightspace.
 	Tips for Applying Dates in Brightspace: Get practical advice on effectively using dates to structure your course and improve communication.
 
 Brightspace Date Terminology
 Due Date Due date indicates when an activity or topic is expected to be submitted or completed. Due dates do not prevent access or submission. Items that are completed or submitted after the due date, such as quizzes or assignments, will be marked as late in Brightspace. Most content with a due date will automatically appear in the calendar and students will receive notifications regarding approaching deadlines in Brightspace.
  Availability Availability refers to the window of access. Availability allows the instructor to open and close access with Start and End dates.
  Start date Start date opens access to content, activities, or assignment submissions.
  End date End date is applicable to both topics and activities, including Discussions, Assignments, and Quizzes, and serves as a firm deadline. Once this deadline has lapsed, the topic or activity becomes inaccessible to students. There is no provision for late submissions after the end date has passed. While this ensures strict adherence to deadlines, it may pose challenges for students with valid reasons for late submissions, such as technical issues or extenuating circumstances. Exceptions can be made for specific students through the ‘Special Access’ option.
  Special access Special access sets conditions to open access to certain students outside the specified dates. Special access is set by the instructor when needed.
  Hide from Users Hide from Users hides content or activities from students until the box is unchecked. An Availability Start date does not override the Hide from Users option.
  Display to calendar Display to calendar is a check box that, when selected, pushes items to the calendar.
  [image: ]
 Due, Start, and/or End Dates can be added to Content topics, Content modules, Discussions, Quizzes, Assignments, and Surveys.
 
 
 Availability Dates for Discussions and Assignments
 [image: ]Availability refers to the window of access for content, an activity or assessment in Brightspace. Start dates are used to open access and end dates close access.  In addition to start and end dates, instructors can also set visibility conditions for Discussions and Assignments.
 Visibility Settings for Discussions
 Setting visibility conditions is an effective way of closing a conversation while allowing users to refer back to threads. Consider setting the Topic to “Visible with submission restricted” after the End Date, and then pinning a summary thread of your own within the Topic so that it appears at the top of the list for viewers.
 	Visible with access restricted: The forum or topic is visible to learners before or after the start or end date, but they cannot access it.
 	Visible with submission restricted: The forum or topic is visible to learners before or after the start or end date and they can access it, but they cannot post new threads or replies. This effectively makes a discussion read-only outside of the availability dates.
 	Hidden: The forum or topic is hidden from learners until the start or end date. Calendar events for Availability Start and Availability End are hidden until the start or end date. Notifications are also not sent until the start or end date.
 	Add availability dates to Calendar: Add the start date and end date of your discussion to the course Calendar.
 
 To access the visibility options for a discussion forum: 	Go to the forum’s Restrictions tab.
 	Click the box next to Has Start Date and/or Has End Date.
 	Set a Start and/or End date.
 [image: ]
 
  To access the visibility options for a discussion topic: 	Go to the Availability Dates and Conditions menu for the discussion.
 	Set the Start and/or End Date.
 	Click Visible with access restricted.
 [image: ]
 
  Visibility Settings for Assignment Submission Folders
 	Visible with access-restricted (before start / after end). The assignment will be visible to learners before the Start Date or after the End Date, but they cannot click or open it. Learners can see the name, dates, and restrictions but cannot see the assignment description or attachments.
 	Visible with submission-restricted (before start / after end). The assignment will be visible to learners before the Start Date or after the End Date, and they can click or open it, but they cannot submit or mark it as complete. Learners can see all details about the assignment, including description, attachments, and rubrics, but they cannot upload files, enter comments, or mark the assignment as complete (for observed in person / on paper submission).
 	Hidden (before start / after end). The assignment is hidden from learners until the start date is reached or after the end date passes. Learners cannot see the assignment anywhere, including corresponding Calendar events and Notifications.
 	Add availability dates to Calendar: Add the start date and end date of your assignment to the course Calendar.
 
 To access the visibility options for an assignment:
 	Go to the Availability Dates and Conditions menu for the assignment submission folder.
 	Set the Start and/or End Date.
 	Click Visible with access restricted.
 
 Due Dates and Availability Dates for Assignment Submission Folders and Quizzes
 Assignment submission folder settings allow you to set both due dates and availability windows (Start and/or End dates). You might consider setting a due date to allow for late submissions of assignments. These assignments will be marked as late by Brightspace. By adding an end date at a later time, it will close off the assignment folder preventing any further late submissions.
 [image: ]
 Quiz settings allow you to set both due dates and availability windows (Start and/or End dates).
 	Due Dates: Use due dates if the quiz is always available, but you would like students to complete it by a certain date.  	Due dates will allow a student to take a quiz past the deadline, but it will be marked late.
 	Due dates will automatically appear in the calendar.
 
 
 	Start/End Dates: For more controlled exams, specify an availability window for quiz access by setting Start and End dates. 	Start and End dates set the availability for students to begin a quiz, not the time limit that they have to complete the exam once they begin. For example, if a 90-minute exam has a Start date of April 6 at 10:00 and an End date of April 6 at 10:30, students could begin the exam anytime between 10:00 and 10:29 and then get the full 90 minutes to complete it. Anytime 10:30 or later, they will not be able to begin the quiz.
 	Start and End Dates will not automatically appear in the calendar. To add them, check the box Add availability dates to Calendar below the End date.
 
 
 	Avoid Using Both Due and End Dates: End dates override due dates. Although you can set both, this can be confusing for students so we recommend using one or the other. Due dates are generally used when the quiz is low or no-stakes, not order dependent within the course, and/or always available throughout the semester; End dates are generally used to control access to higher stakes exams.
 [image: ]
 
 Answers to your questions
  An interactive H5P element has been excluded from this version of the text. You can view it online here:
 https://pressbooks.bccampus.ca/langaraquickguides/?p=955#h5p-7 
 
 Did you know?
  An interactive H5P element has been excluded from this version of the text. You can view it online here:
 https://pressbooks.bccampus.ca/langaraquickguides/?p=955#h5p-8 
 
  
 Key Takeaways
  	Adding dates to LMS items allows you to effectively structure your course and guide students through the learning process, while also enabling students to manage their time efficiently and stay on top of their coursework.
 	Students cannot see Hidden items.
 	Instructors use due dates to inform students of when an assignment or topic should be submitted or finalized. End dates act as strict cut-off points, preventing students from accessing the topic or activity beyond this time.
 	Instructors must apply Special access conditions to permit specific students to submit assignments or access materials past the End date.
 
 
 
 [image: ]
 Setting up availability dates and other restrictions can be complex, especially if associated with a high-stakes and time-sensitive learning activity. Please contact EdTech if you’d like us to review your date settings.
 
 
 
 Contact edtech@langara.ca for more information.
 [image: ]
 If you are a Langara employee, self-register for Essentials to Excellence: A Brightspace Companion for Instructors. This Brightspace course compliments the technical instructions found here with use cases, examples, and advice.
 
	

			
			


		
	
		
			
	
		

		

								

	
				Groups
 [image: Brightspace logo]
 Having students work within smaller groups for specific projects or activities can increase engagement. The Brightspace Groups tool facilitates the setup and organization of group activities. Groups is often used in conjunction with Discussions and Assignments.
 
 
 Things to consider
 Before setting up Groups in Brightspace, consider preparing the following:
 Group Purpose Define clear objectives for using groups. Whether for discussions, assignments, or projects, having a well-defined purpose helps you select the appropriate group settings and communicates to students why they’re working in groups.
  Group Formation Strategy Decide how you want to form groups based on your pedagogical goals:
 	Random assignment works well for short-term activities
 	Self-enrollment gives students agency and may increase engagement
 	Instructor-assigned groups allow for balanced composition (skill level, experience, etc.)
 	Single-user groups can be useful for individual reflections or sign-ups
 
  Group Size Consider the optimal size for your activity:
 	Smaller groups (2-3) encourage full participation but provide less diversity of perspectives
 	Medium groups (4-5) balance participation and diversity
 	Larger groups (6+) provide more perspectives but may lead to uneven participation
 
  Group Tools Determine which Brightspace tools the groups will use:
 	Discussion areas: For group conversations and collaborative idea development
 	Assignment folders: For group submissions of projects or assignments
 	Lockers: For file sharing among group members
 
  Timeline Plan the group activity timeline:
 	When will groups be formed?
 	How long will students work in these groups?
 	Do you need enrollment start/end dates for self-enrollment?
 
  Communication Prepare clear instructions for students about:
 	How to find their group
 	What they’re expected to do within their group
 	How to communicate with group members
 	How their group work will be evaluated
 
 Students can belong to multiple groups within the same course. For example, each student can simultaneously belong to a group for the class project, a group for a special interest discussions, and group of one for journalling. Each group can have its own discussions forums, assignments, and locker area to work in. You can grade members of groups individually or as a team.
  To create groups in Brightspace:
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://pressbooks.bccampus.ca/langaraquickguides/?p=1697#oembed-1 
 
 Step-by-step guide to creating groups Step 1: Go to My Tools > Groups.
 [image: Find groups by selecting "My Tools" on the navigation bar and then selecting "Groups" from the dropdown.]
 Step 2: Click the New Category button to begin creating groups.
 [image: New category to start creating groups.]
 Step 3: Enter a Category Name (required) and an optional description.
 	Choose a descriptive name that clearly identifies the purpose (e.g., “Project Teams” or “Discussion Groups Week 3”)
 	The description can provide context for both you and your students
 
 [image: Category name and description.]
 Step 4: Select the appropriate Enrollment Type based on your needs:
 [image: Enrolment type: number of groups, groups of a specified number, single user, auto or self-enrolment...]
 
 	# of Groups – No Auto Enrollments: Creates empty groups for manual assignment (best when you want specific student combinations)
 	Groups of #: Creates groups with a specific number of members (e.g., “groups of 4 students each”)
 	# of Groups: Creates a specific number of total groups (e.g., “6 groups total”)
 	Groups of # – Self Enrollment: Allows students to join groups themselves (good for student agency)
 	Single User: Creates individual groups with one member each (useful for reflective activities or sign-ups)
 
 
 
 Step 5: Configure the Advanced Properties (options vary based on enrollment type):
 If you choose the Groups of # or # of Groups enrollment types, you will have three additional options under Advanced Properties.
 	Auto-enroll new users – If enabled, this setting will automatically add any new students to a group in this category if they are added to the course later.
 	Randomize users in groups – If enabled, this will enroll students in a random order. If this is not enabled, students will be enrolled based on their order in the classlist.
 	Make category and group descriptions visible to group members.
 
 For automatic enrollment, choose whether to randomize users in groups (recommended for most cases)
 For self-enrollment, set enrollment start and end dates if needed (e.g., give students one week to join)
 Step 6: Select Additional Options as needed:
 	Discussion areas: Creates group-specific discussion forums where only group members can participate
 	Lockers: Provides file-sharing space for group members to exchange documents
 	Assignment submission folder: Creates a group assignment submission area for collaborative work
 
 Step 7: Click Save to create the groups. The system will process your request in the background.
 	You’ll see a notification that groups are being created
 	You can continue with other tasks while this processes
 
  Group Enrollment Types Explained
 When creating groups in Brightspace, you’ll need to choose how students will be assigned to groups. Here’s what each enrollment type means in plain language:
 Understanding Group Enrollment Types # of Groups – No Auto Enrollments
 What it means: You specify how many empty groups to create, with no students automatically added.
 Best for: When you want complete control over which students go into which groups.
 Example: Creating 5 project teams where you’ll manually place students based on their skills or interests.
 Groups of #
 What it means: You specify how many students should be in each group (e.g., groups of 4).
 Best for: When you have a specific group size in mind for effective collaboration.
 Example: Creating discussion groups with exactly 3 students per group for focused conversation.
 # of Groups
 What it means: You specify the total number of groups, and students are distributed evenly across them.
 Best for: When you need a specific number of groups regardless of exact size.
 Example: Creating 6 lab groups to match the number of lab stations, with students evenly distributed.
 Groups of # – Self Enrollment
 What it means: You create groups with a maximum size, and students choose which group to join.
 Best for: When you want to give students agency in selecting their groups.
 Example: Creating “Topic Selection” groups where students join the topic that interests them most.
 Single User
 What it means: Each group contains exactly one student.
 Best for: Individual activities, sign-ups, or one-on-one interactions.
 Example: Creating presentation time slots where each student signs up for a specific time.
  Important Notes on Group Types 	With automatic enrollment, students are assigned to groups in order from the class list unless you select “Randomize users in groups”
 	Self-enrollment can have a time limit (enrollment period) after which remaining students can be automatically assigned
 	Enrollment types determine which advanced properties are available to customize
 
  The group enrollment type options can be confusing. Watch the following video to get more information.
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://pressbooks.bccampus.ca/langaraquickguides/?p=1697#oembed-2 
 
 	The maximum number of students per individual group is 200.
 	Single user groups: this option can be used if you want to give students a personal space to journal that can only be accessed by the student and the instructor.
 	Users can belong to multiple groups within the same course but cannot self-enrol in more than one group in the same category.
 	“Restrict Enrolments To” will not be an available option in most situations, with the exception of a combined course that has more than one section. In that case, you can create groups that are restricted by section.
 
 
 Group Discussions
 Group discussions create focused conversation spaces where students can only see and interact with posts from members of their own group. This creates smaller, more manageable discussion communities within your course.
 When you enable group discussions:
 	Students can only view and respond to posts from their own group members
 	You (the instructor) can see and participate in all group discussions
 	Each group has its own dedicated discussion space
 	Grading is streamlined, making this ideal for assessed discussions
 
 You can set up group discussions in two ways:
 	During group creation: Select “Discussion areas” under Additional Options when creating groups
 	For existing groups: Create a new discussion topic and link it to your group category
 
 Important: Once a discussion topic is created, you cannot convert it between a regular (open) topic and a group topic. Choose the right format from the beginning.
 For detailed instructions on creating discussions, visit the Discussions Quick Start Guide.
 Assignment Folders for Group Submissions
 Group assignment folders allow teams to collaborate on a single submission. This simplifies the submission process for group projects and ensures all team members have access to the same feedback.
 You can create group assignment folders in two ways:
 	During group creation: Select “Assignment submission folder” under Additional Options when setting up groups
 	For existing groups: Create a new assignment and link it to your group category during setup
 
 When using group assignment folders:
 	One submission represents the entire group’s work
 	All group members can contribute to the submission
 	Grades and feedback are shared with all group members
 	You can choose whether each student submits individually or the group submits once collectively
 
 For complete instructions on creating assignments, visit the Assignments Quick Start Guide.
 Use Cases for Groups
  Collaborative Projects
 Create groups with an assignment folder to facilitate team projects. Students can collaborate on reports, presentations, or research tasks with shared submission and evaluation.
 Example setup: Groups of 4-5 students with both a group locker (for file sharing) and a group assignment folder (for final submission).
 
 Group Discussions
 Foster focused discussions on course topics by creating smaller discussion groups where students can engage more deeply with concepts.
 Example setup: Groups of 6-8 students with discussion areas only, using “Create one topic with threads separated by group” for easier monitoring.
 
 Peer Review Activities
 Set up groups where students can provide feedback on each other’s work through structured peer review.
 Example setup: Groups of 3 students with discussion areas for sharing feedback, possibly rotating groups for different assignments.
 
 Individual Sign-up Slots
 Use single-user groups with self-enrollment to allow students to sign up for presentation times, lab sessions, or office hours.
 Example setup: Single-user groups with descriptive names like “Monday 10:00 AM Presentation” and self-enrollment option.
 
 
  
 Further Resources
 	
 	See the student view of groups
 	Learn how to email groups
 	Find out how to modify groups
 
 
 
 Contact edtech@langara.ca for more information.
 [image: ]
 If you are a Langara employee, self-register for Essentials to Excellence: A Brightspace Companion for Instructors. This Brightspace course compliments the technical instructions found here with use cases, examples, and advice.
 
	

			
			


		
	
		
			
	
		

		

								

	
				Intelligent Agents
 [image: ]
 Intelligent Agents function as automated assistants withing Brightspace that continuously monitor student activity according to parameters you establish. When students meet specific criteria you’ve defined, the agents automatically trigger actions such as personalized notifications or alerts. Think of them as your virtual teaching assistants that work 24/7!
 This guide will help you set-up Intelligent Agents and recommend a few that you may want to try out.
 
 
 
 3 Intelligent Agents Every Instructor Should Consider
 	The Engagement Monitor
 Monitors login activity to identify disengaged students early
 
 		Criteria: No login for 5-7 days
 	Action: Personalized check-in email
 	Frequency: Weekly
 
 
 
 	The Early Warning System
 Identifies struggling students based on assessment performance
 
 		Criteria: Release condition for scoring below 70% on a quiz/assignment
 	Action: Email with support resources and office hours
 	Frequency: Run after each major assessment
 
 
 
 	The Celebration Messenger
 Recognizes student achievements with positive reinforcement
 
 		Criteria: Release condition for high performance (85%+)
 	Action: Congratulatory email
 	Frequency: One-time per student per achievement
 
 
 
 Before you Begin: Set Custom Email Values for Your Course
  Before creating any Intelligent Agents, customize your email settings so messages come from you rather than a generic system address:
 	Navigate to Course Admin > Intelligent Agents
 	Click the Settings icon in the top right corner
 	Select Set custom values for this course
 	Enter your name in the Name that emails come from field
 	Enter your email address in the Reply-To address for responses field
 	Click Save
 
 [image: ]
 Important Note: Langara’s Brightspace instance does not have an internal email system. When Intelligent Agents send emails, they go to recipients’ Outlook inboxes. All subsequent communication between instructors and students happens through Outlook email, outside of Brightspace. Make sure your reply-to address is your Langara email account that you regularly check.
 
 
 To create Intelligent Agents in Brightspace:
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://pressbooks.bccampus.ca/langaraquickguides/?p=2543#oembed-1 
 
 Step-by-step guide to creating an Intelligent Agent Step 1: Access and Start the New Agent Process
 	Go to Course Admin > Intelligent Agents
 	Click New Agent
 
 Step 2: Name and Enable Your Agent
 	Enter an Agent Name (be specific and descriptive)
 	Add a helpful Description for future reference
 	Select or create a Category (optional, helps with organization)
 	Check “Agent is enabled” to activate immediately
 
 [image: ]
 
 Step 3: Set Your Schedule
 	Expand Scheduling
 	Select Frequency (Hourly, Daily, Weekly, Monthly, or One-Time Run)
 	Configure schedule details based on frequency selected
 
 [image: ]
 
 Step 4: Define Your Criteria
 	Expand Criteria
 	Select user roles: All users or specific roles
 	Choose monitoring type: 	Login Activity: Hasn’t/has logged in for X days
 	Course Activity: Hasn’t/has accessed course for X days
 	Release Conditions: Create or attach existing conditions
 
 
 
 [image: ]
 
 Step 5: Configure Actions
 	Expand Actions
 	Set Repetition: First time only or every time criteria are met
 	Select “Send an email when criteria are satisfied“
 	Complete email details using replace strings for personalization
 
 [image: ]
 
 Step 6: Test Your Agent
 Use Practice Run from the agent’s context menu to check results before enabling for real use
 [image: ]
 
  
 Common Replace Strings for Personalized Emails
 Replace strings allow you to create one template message that Brightspace will automatically customize for each recipient. When the agent runs, these placeholder codes are replaced with specific student information, making each email feel individually crafted.
 For Email Recipients:
 	{InitiatingUser} – The student who triggered the agent
 
 For Email Content:
 	{InitiatingUserFirstName} – Student’s first name
 	{InitiatingUserLastName} – Student’s last name
 	{OrgUnitName} – Course name
 	{OrgUnitCode} – Course code
 	{LastCourseAccessDate} – Last date student accessed the course
 	{LastLoginDate} – Last date student logged into Brightspace
 	{LoginPath} – Direct link to Brightspace login
 
 For a complete list of Brightspace replace strings, see the D2L documenation to Automatically Customize Course Content Using Replace Strings.
 Sample Email Templates
 Engagement Check-in Email Subject: Checking in regarding your participation in {OrgUnitCode}
 Dear {InitiatingUserFirstName},
 I’m writing because I noticed you haven’t accessed our {OrgUnitName} course since {LastCourseAccessDate}. Regular engagement with course materials and activities is strongly correlated with academic success in this course.
 If you’re experiencing any challenges with the course content or have other circumstances affecting your participation, please don’t hesitate to contact me. I have office hours on [days/times] in [location], or we can arrange a time to meet virtually.
 You can access the course here: {LoginPath}
 I look forward to seeing your continued participation in our upcoming activities.
 Regards,
 [Your Name]
 [Your Contact Information]
  Achievement Recognition Email Subject: Excellent work in {OrgUnitCode}
 Dear {InitiatingUserFirstName},
 I wanted to take a moment to acknowledge your excellent performance on the recent assessment in {OrgUnitName}. Your work demonstrated a thorough understanding of the key concepts and strong analytical skills.
 This level of achievement reflects the time and effort you’ve invested in mastering the course material. As we move into more advanced topics in the coming weeks, the foundation you’ve built will serve you well.
 If you’re interested in exploring any aspects of this material in greater depth, I’d be happy to suggest additional resources or discuss potential applications during office hours.
 Keep up the excellent work.
 Regards,
 [Your Name]
 [Your Contact Information]
  Did You Know?
  Data-Driven Teaching Decisions: Many instructors use Intelligent Agents primarily as data collection and alert systems rather than direct student communication tools. By setting up agents to only notify you when certain criteria are met (enter only your email address in the “To” field), you maintain complete control over how and when to respond to student needs. This approach respects your professional judgment about individual student circumstances – such as extensions you’ve granted, personal situations you’re aware of, or students who might benefit more from an in-person conversation than an automated email. You get the data you need to make informed decisions while preserving the human element in your teaching relationships.
 To learn more, visit Carleton’s page on using Intelligent Agents to create data reports.
 
 
  
 Early Warning System Email Subject: Action Required: Course Progress in {OrgUnitCode}
 Dear {InitiatingUserFirstName},
 I’m reaching out because I’ve noticed some concerns with your recent assessment in {OrgUnitName}. Your current performance suggests you may benefit from additional support with the course material.
 I encourage you to:
 1. Review the feedback provided on your recent submission
 2. Utilize the learning support resources available at the college (Learning Commons, [location], [hours])
 3. Attend my upcoming office hours on [day] between [times] in [location]
 The concepts covered in this module are foundational for our upcoming topics, so addressing any gaps in understanding now will be beneficial for your success moving forward.
 Please let me know if you would like to discuss specific strategies to strengthen your understanding of these concepts.
 Regards,
 [Your Name]
 [Your Contact Information]
  
  Tips for Intelligent Agent Success
 	Use clear naming conventions (e.g., “Week 2 Content Check-in” rather than “Agent 1”)
 	Start small with 1-2 agents before expanding
 	Always test with the Practice Run feature
 	Consider instructor alerts first — send emails to yourself to review data before deciding on student communication
 	Avoid overwhelming students with too many automated messages
 	Review agent performance periodically and adjust as needed
 	Use categories to organize agents by purpose or timing
 	CC yourself on agent emails to monitor what students receive
 	Customize emails to match your teaching voice and style
 	Consider timing of when agents run (e.g., working hours vs. middle of night)
 	Document successful agents for reuse in future courses
 
 
 Contact edtech@langara.ca for more information.
 [image: ]
 If you are a Langara employee, self-register for Essentials to Excellence: A Brightspace Companion for Instructors. This Brightspace course compliments the technical instructions found here with use cases, examples, and advice.
 
	

			
			


		
	
		
			
	
		

		

								

	
				Semester Start Checklist
 [image: ]
 To ensure your Brightspace course is fully prepared and ready for students at the start of semester, please complete the semester start checklist below. This checklist covers essential steps to provide a seamless learning experience for your students.
 
 
 [image: ]View your course on your phone
 Many students use their phones to access course content on Brightspace. Try viewing your course content on your own mobile device to see if any content you’ve created is inaccessible.
 Things to consider:
 			Does your content reflow?
 	Is the font large enough?
 	Does important information appear at the top on your course homepage?
 
 
 
 
 
 [image: ]Preview your course as a student
 Previewing your course in advance will give you a sense of what your students see when they are navigating through your course. In addition to previewing your course you can also preview quizzes, assignments and grades.
 Watch this playlist demonstrating how to preview Brightspace content as a student.
 [image: ]
 Add a welcome announcement
 A detailed welcome message or video at the beginning of the course introducing the instructor, course objectives, and what students can expect sets a warm, engaging tone and clarifies the course’s purpose.
 Here are instructions on how to create a Welcome Announcement.
 [image: ]
 Review accessibility features
 Check that your course meets accessibility standards. Use the Brightspace Accessibility Checker to determine if content pages are accessible.
 Click here for more information about the Brightspace Accessibility Checker.
 [image: ]
 Provide your contact information
 Opening avenues for communication, and providing easy access to those channels supports learner-instructor interaction, and facilitates engaging in supportive contact and interaction, a key component of social presence.
 [image: ]Test multimedia elements
 Ensure all videos, audio files, and interactive elements work correctly on various devices and browsers.
 [image: ]
 Check all hyperlinks
 If time permits, click all your hyperlinks to ensure they are working properly. Brightspace content that is copied from other courses can sometimes contain broken Quicklinks or broken Topics.
 [image: ]Verify assessment settings
 Double-check the settings for quizzes, assignments, and discussions. Ensure due dates, availability dates, and grading settings are correct.
 [image: ]Set your Brightspace course to Active
 Your course is not automatically available to your students. It needs to be set to Active AND the semester needs to have officially started.
 Follow these instructions to set your course to Active.
 [image: ]Talk to EdTech
 If you have questions about setting up your course, organizing content, using tools, or the accessibility of your course, please contact EdTech to arrange a review of your Brightspace course.
 [image: ]
 
 
 Contact edtech@langara.ca for more information.
 [image: ]
 If you are a Langara employee, self-register for Essentials to Excellence: A Brightspace Companion for Instructors. This Brightspace course compliments the technical instructions found here with use cases, examples, and advice.
 
	

			
			


		
	
		
			
	
		

		

								

	
				Self-Registration
 [image: ]
 Some Brightspace courses are available for self-registration. These are often asynchronous training or information courses.
 
 
 To Self-Register in a Brightspace Course
 Step 1
 Login to Brightspace and select the Self Registration link on the top left.
 [image: ]
 
 Step 2
 Select the course from the available course list.
 [image: ]
 
 
 Step 3
 Click the Register button on the bottom right.
 [image: ]
 
 Step 4
 Click Submit.
 [image: ]
 
 
 Step 5
 Click Finish and you’re registered in the course.
 [image: ]The course will now appear on your Brightspace home page and the course selection menu.
 Tip: You can pin the course to the top of your home page by clicking the ellipsis (…) on the top right of the course and select Pin.
 [image: ]
 
 Contact edtech@langara.ca for more information.
 [image: ]
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				Padlet
 [image: Brightspace logo]
 Padlet is a real-time collaborative web platform for sharing, collaborating, and organizing. Padlet creates virtual bulletin boards called “Padlets” in a range of formats and styles.
 
 
  
 Use Padlet for:
 	Introductions
 	Discussions
 	Brainstorming
 	Project Planning
 
 
 	Collaboration
 	Team-building
 	Resource curation
 	Presenting
 
 
 	Showcasing student work
 	Peer evaluation
 	Exit tickets
 	Concept mapping
 
 
 
 Langara has a limited number of licenses for Padlet. Contact edtech@langara.ca to obtain a license.
 
 Getting Started with Padlet
 	Visit the Langara Padlet login page and use the Padlet credentials provided via email.
 	On the Padlet dashboard, click Make a padlet (in the top right corner).
 
 [image: ]
 Making Padlets
 [image: ]Choose between a Blank board or a template from the Gallery – hover over the templates in the gallery to see how they can be used.
 
 Blank
 If you choose a blank board, you start from scratch. Give your board a Title, choose the Format of the board, and the level of organization of your posts.
 [image: ]
 
 Template
 If you choose a template, your Padlet will include additional instructions, information, and examples of use.
 [image: ]
 
 
 
 Padlet Settings
 Update your Padlet settings by clicking the cog icon on the right-hand side.
 [image: ]
 In the Settings menu you can change the Heading, Appearance, Layout, Engagement, Posts, and Content settings of your Padlet.
 [image: ]
 
 
 Share your Padlet
 Update your Padlet permissions settings by opening the Share menu – click the arrow icon on the right-hand side.
 [image: ]
 Change your Visitor permissions (under the Collaborators heading) from No access to Reader, Writer, or Moderator.[image: ]
 
 
 Sharing
 [image: ]Move to the Share tab to share your Padlet with your students using a link, QR code, embed into Brightspace or PebblePad, etc.
 
 
 Visit the Padlet Help website for more information or contact edtech@langara.ca [image: ]
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				Microsoft Forms
 [image: ]
 Microsoft Forms can enhance audience engagement and provide real-time feedback via polling. Live polls can be seemlessly incorporated in Microsoft PowerPoint presentations to collect, and display, responses in real-time. Forms can also collect feedback and other data. A form embedded in your Brightspace course can make asynchronous data and feedback collection easier.
 
 
 To Access Microsoft Forms
 	Login to Microsoft365.
 	Select Apps on the left side toolbar.
 [image: ]
 	Click All apps and select Forms.
 [image: ]
 
 
 To create a Form:
 	Click on New Form on the top left.
 [image: ]
 	Give your Form a meaningful and unique title.
 	Select a question type to begin.
 [image: ]
 Question options include: Choice, Text, Rating, Date, Ranking, and Likert.
 	Enter question details. 	Adjust settings for each question, such as making a question required, allowing multiple answers, and adding branching based on response.
 
 
 	Continue to Add new question.
 
 To collect responses asynchronously:
 	Select Collect Responses.
 [image: ]
 	Forms can be shared via URL, directly in Outlook or Teams, via QR code, or embed code.[image: ]
 Permissions can be set to allow anyone, authenticated users (with an option for anonymous responses), or specific people to respond. 
 
 [image: ]
 Note: EdTech recommends the Anyone can respond option as this allows respondents to remain anonymous and does not require them to login with their Microsoft credentials.
 
 
 Microsoft Forms automatically saves your work. You can find all items you have created under My forms. 
 Tips for Effective Polling
 	Keep It Simple: Use clear and concise questions to avoid confusion.
 	Engage Early: Incorporate a poll early in your presentation to capture attention.
 	Encourage Participation: Remind your audience to participate and explain how their feedback will be used.
 	Analyze Results: Use the poll results to gauge understanding and adapt your presentation accordingly.
 
 [image: ]
 Microsoft Forms is part of Langara’s Microsoft 365 Suite of tools and has undergone required privacy and risk assessments.
 
 
 
 Contact edtech@langara.ca for more information.
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				Microsoft Forms Quiz
 [image: ]
 Microsoft Forms Quiz is a specific feature within Microsoft Forms tailored for creating quizzes and assessments, particularly for educational purposes. It can create engaging, self-paced knowledge assessments, allowing for a deeper understanding of asynchronous learning progress. It includes all the features of Microsoft Forms, but with additional capabilities specific to creating quizzes such as assigning points to questions and setting correct answers. Microsoft Forms Quizzes also provides features for automatically grading responses and providing immediate feedback to students.
 
 
 Use Microsoft Forms Quizzes for:
 	Practice quizzes
 	Knowledge checks
 
 
 To Access Microsoft Forms
 	Login to Microsoft365.
 	Click Apps on the left side toolbar.
 [image: ]
 	Click All apps and select Forms
 [image: ]
 
 
 Creating a Quiz
 	Click New Quiz on the top left.
 [image: ]
 	Give your Quiz a title and then click Add new.
 [image: ]
 
 	Build your quiz by choosing from the question types.
 [image: ]
 	Add point values to your questions and mark them as Required, if necessary.
 [image: ]
 Note: Additional options are available depending on the type of question – clicking the ellipsis (…) brings up more options.
 	Once all questions are added, click the ellipsis on the top right corner of your quiz and select Settings to verify your quiz settings before sharing – determine if the quiz is for practice, if results will be shown to students after submitting, the start and end date, the quiz duration, etc.
 [image: ]
 
 Microsoft Forms automatically saves your work. You can find all items you have created under My forms.
 Sharing a Quiz
 Once your quiz settings are verified, share your quiz in one of two options: Collect response or Present.
 Collect Response
 Collect responses allows you to copy a link of your quiz, create an invitation, download a QR code, or copy an embed code.
 [image: ]
 
 Present
 Present converts your quiz into a slideshow presentation. The quiz can be completed synchronously, and visualizations update in real-time.
 [image: ]
 
 
 [image: ]
 Responses can be collected anonymously or participants can be required to login via their Langara email address. A spreadsheet with all the responses can be downloaded. Reach out to EdTech for more assistance.
 
 
 
 Contact edtech@langara.ca for more information.
 [image: ]
 
	

			
			


		
	
		
			
	
		

		

								

	
				Presenting Microsoft Forms in PowerPoint
 [image: ]
 Forms and quizzes created in Microsoft Forms can be integrated directly into PowerPoint, allowing for real-time engagement and knowledge checks.
 
 
 Inserting Microsoft Forms in PowerPoint (Windows desktop app):
 	On a new PowerPoint slide, click the Insert tab and select Forms.
 	Select the form/quiz from the Forms sidebar and click Insert.
 [image: ]
 	When presenting live, choose Present for Interactive meetings. To collect asynchronous responses, choose Collect responses offline.
 
 Inserting Microsoft Forms in PowerPoint (MacOS desktop app):
 	On a new PowerPoint slide, move to the Home tab, open My Add-ins and choose Forms.
 	Paste the link to your form in the Insert your form into a slide window.
 [image: ]
 	When presenting live, choose Present for Interactive meetings. To collect asynchronous responses, choose Collect responses offline.
 	Adjust the Form placement: 	Resize and move the embedded form on your slide as needed.
 
 
 
 Inserting Microsoft Forms in PowerPoint (web browser):
 	On a new PowerPoint slide, click the Home tab > Add-ins > Forms.
 	Paste the link to your form in the Insert your form into a slide window.[image: ]
 	When presenting live, choose Present for Interactive meetings. To collect asynchronous responses, choose Collect responses offline.
 	Adjust the Form placement: 	Resize and move the embedded form on your slide as needed.
 
 
 
 To Collect Responses:
 	Start the PowerPoint Presentation.
 	Engage Your Audience: 	When you reach the poll slide, instruct your audience to participate by scanning the QR code or entering the link.
 	If you wish to have participants respond to the form/quiz prior to displaying the live results, insert a slide before with the QR code and link to the form/quiz.
 
 
 	Wait while audience members respond to the poll in real-time.
 	Display Results: 	As responses come in, you can display the results live on your slide.
 	Discuss the results with your audience to enhance interaction.
 
 
 
 
 Contact edtech@langara.ca for more information.
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				Microsoft Forms FAQ
 Getting Started:
 What is Microsoft Forms, and how can I access it? Microsoft Forms is an online tool that allows you to create surveys, quizzes, and polls, as well as collect responses in real time. It’s user-friendly and integrates seamlessly with other Microsoft 365 apps, making it a great choice for checking in, gathering feedback, conducting assessments, and more in an educational setting.
 Accessing Microsoft Forms:
 	Login to Microsoft365.
 	Click Apps on the left side toolbar.
 	Click All apps and select Forms.
 
  How do I create a new form or quiz in Microsoft Forms? See the Microsoft Forms Quick Start Guide for instructions on creating a new Form.
 See the Microsoft Forms Quiz Quick Start Guide for instructions on creating a new Quiz.
  What is the difference between a form and a quiz in Microsoft Forms? A Form is used for collecting information or feedback (e.g., surveys, polls), while a Quiz is designed for assessments where you can assign point values to questions and provide automatic feedback. In quizzes, you can also track correct/incorrect answers and give grades.
  Customization and Design:
 What types of questions can I create? Select from a range of question types, including:
 	Choice (multiple choice)
 	Text (open-ended answers)
 	Rating (star or number ratings)
 	Date (ask for a date)
 	Likert (scale for agreement levels)
 
 Add the question, provide answer options (if creating a quiz), and set any additional options like required responses or multiple answers.
  Can I add images, videos, or other media to my form/quiz? Yes, you can add media to enhance your form or quiz:
 	For questions, click the Image or Video icon next to the question text field to upload a file or provide a URL.
 	You can also insert media directly into your form’s title section to make it more visually appealing.
 	Ensure your media complies with accessibility guidelines for all users.
 
  How can I reorder or edit questions in a form/quiz? To reorder questions:
 Click the drag handle ([image: ]) at the top of the question and reorder the question.
 or
 Click on the question you want to move and use the up or down arrow ([image: ]) next to the question to change its position.
 To edit a question:
 	Click on the question itself to make changes.
 	You can modify the text, answer choices, or settings (e.g., required field) directly in the editor.
 
 If you want to change a question type, delete the question and add new.
  Collaboration and Sharing:
 How do I share my form/quiz with colleagues or students? 	Click Collect Responses in the upper-right corner of the form you wish to share.
 	Choose your sharing options: 	Anyone with the link can respond (for public access, anonymous, no sign-in required)
 	Only people in Langara College can respond (for internal use, can record name, sign-in required)
 	Specific people in  Langara College can respond (for internal use, can record name, sign-in required)
 
 
 	Copy the link, generate a QR code, or share directly via email or Teams. You can also embed the form on Brightspace, in PowerPoint, and in OneNote.
 
  Can I collaborate with others on creating or editing a form/quiz? Yes! To collaborate:
 	Click the ellipsis on the top right corner of the form and select Collaborate or Duplicate.
 	Click Share the link to collaborate and view result.
 	Choose from the dropdown, who can collaborate on your form/quiz. We recommend sharing with Specific people in Langara College with the link can edit and view result.
 [image: ]
 	Copy and Share the link with colleagues
 
  How can I insert my form/quiz into PowerPoint? See the Presenting Microsoft Forms in PowerPoint Quick Guide for instructions.
  Data Collection and Analysis:
 How can I view and analyze responses from my form/quiz? To view responses:
 	Go to the Responses tab at the top of your form.
 	Here, you can see a summary of all responses with charts and graphs.
 	For a more detailed view, click View Results to see individual responses.
 
 For advanced analysis:
 	Click the Excel Spreadsheet to view all the response data.
 	You can sort, filter, and analyze responses.
 
  How do I set up notifications for new responses? To receive notifications for new responses:
 	In the Settings menu(gear icon) on the top right of your form/quiz, check the box next to Get email notification of each response.
 	Provide the email you wish to receive notifications.
 	You will receive an email every time a new response is submitted.
 
  Can I set a deadline for responses? Yes, you can set a deadline:
 	Go to the Settings menu (gear icon) on the top right of your form/quiz.
 	Check the option for Start Date and End Date.
 	Set the dates and times for when the form will open and close to responses.
 
  Troubleshooting:
 Why aren’t my responses showing up correctly? If responses aren’t showing correctly:
 	Ensure the form is still open and hasn’t been closed or restricted.
 	Check if any filters or validation settings are affecting the responses.
 	Make sure all respondents are using updated browsers and devices.
 
 If the issue persists, try exporting the responses to Excel to see if the data is captured but not displaying.
  Additional Resources: 	LinkedIn Learning Microsoft Forms Quick Tips​
 	Share a form or quiz to collaborate​
 	Check and share your form results ​
 	View results of your form
 
  
 Contact edtech@langara.ca for more information.
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				Direct, succinct title (no “Quick Guide”)
 [image: ]
 Blurb that mentions briefly what tool is and what it’s used for. 1 short paragraph
 
 
 
 Our Recommendations
 [image: ]
 	Collect any “Our recommendation” callouts and list here
 	IF APPLICABLE, otherwise delete
 
 
 
 Before you get started
 Quick considerations before starting, IF APPLICABLE
 Step-by-step Instructions
 To [complete specific task]:
 Step 1: first step
 
 “Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat. Duis aute irure dolor in reprehenderit in voluptate velit esse cillum dolore eu fugiat nulla pariatur. Excepteur sint occaecat cupidatat non proident, sunt in culpa qui officia deserunt mollit anim id est laborum.”
 Our Recommendation
 [image: ]
 If there are multiple ways to do things, be explicit about this being our recommended way. The unwritten piece is ‘you have done it that way but this way is better.’ Provide brief justification for recommendation.
 
 
 Step 2: second step
 
 Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.
 Images can be placed however, but example images and details should be marked:
 Example
 Student view of grade book with Final Calculated Grade released[image: Student view of grade book with Final Calculated Grade released]
 Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.
 Further Resources
 Use textbox for key takeaways, links, next steps, etc.
 Try to avoid back-to-back textboxes
 [image: ]
 Only use disclaimer box if there is an actual disclaimer or particularly important note to remember
 
 
 For an immersive experience with this tool and many other Brightspace features, enroll in Essentials to Excellent: A Brightspace Companion for Instructors. This self-directed course offers examples, use cases, and extended information on how to use Brightspace to enhance the student experience.
 [image: ]
 Where applicable add in call to action/invitation to move to the page (e.g., from Question Library to Quizzes) and link to next page!
 
 
 Contact edtech@langara.ca for more information.
 [image: ]
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